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PREFACE to the FIRST EDITION 

 A huge number of geology lab manuals are available from many different publishers, so 
why did Dixie State College’s faculty write their own? Well, for several reasons, all of which are 
specifically intended to help students enrolled in the GEO 1015 labs: 

• First and foremost, essentially all of the available geology lab manuals are written for geology 
majors—people intending to make geology their careers. Introductory geology labs for 
geology majors are specifically designed to train those majors to be future geologists and give 
them basic skills and knowledge that forms the foundation for such a career. However, 
DSC’s GEO 1015 lab course (and the accompanying GEO 1010 lecture) is a general 
education course, and not intended for majors. You and other students in this class do not 
need to be trained as would be future geologists. So the labs in this manual have a very 
different focus: instead of training future geologists, they are specifically designed to enable 
you to see how many aspects of geology—and science in general—impact you in everyday life, 
even in ways that you do not think about. Of course, along the way, you will still learn the 
basic principles of geology (which are necessary to understand why they affect you). 

• While you will do some things that you might expect in these labs—such as learn to identify 
different mineral and rock types and various geological formations and structures—much of 
these labs involves using computers to find information about how geology affects you and 
will continue to affect you in everyday life, whether you realize it or not. In some cases, such 
as the geologic hazards lab, the potential effects will be quite obvious; in others, such as the 
plate tectonics lab, they may be less so, but they are there! Having computer-based exercises 
may seem a strange thing to do in a geology course, but they are specifically designed to 
enable you to learn how you can find, understand, and use geological information even 
outside of class. Knowing that such information is accessible, you can use such information 
in the future to make decisions about geological factors that will impact your life (for 
example, picking a place to buy a house based on geologic hazards, or why cell phones and 
other electronics are so expensive, which is a function of the rarity of some of the minerals 
that are required to make critical components). 

• Many of the questions in the lab exercises in this manual have a Utah-based focus. This is to 
enable you to learn more about the specific geology that you have seen, see every day, and 
may well encounter in the future elsewhere in Utah, as well as gain an understanding of 
some of the broader implications of Utah’s geological resources for the rest of the world. 
Utah is an especially rich place in terms of geology, and interacting with its geology is 
unavoidable! Of course, the principles you learn in this course apply all over the world (and 
even on other worlds!), so even if you leave Utah, what you learn in this lab will travel with 
you. 

• Other lab manuals are extremely expensive—because they are intended for geology majors, 
non-majors, such as yourself, would not use substantial portions of those manuals, which 
just wastes your money! 

 Please note that your GEO 1015 lab section complements the GEO 1010 lecture course in 
which you are also enrolled! The lab schedule (see your syllabus) has been designed, with the 
cooperation of the GEO 1010 lecture instructors, to purposefully stay behind the lecture schedule. 
This way, the concepts you will be applying in lab will have been introduced in the lectures first. 
However, this means that you are responsible for knowing and understanding that material before 
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you begin a lab! Your lab instructor cannot spend lab time lecturing in detail on any subject—lab 
time needs to be devoted to you doing the lab activities. However, your lab instructor will be more 
than happy to explain concepts with which you have had difficulty from the lecture and/or lecture 
textbook—after all, the labs are intended to help reinforce the lecture material! If you are having 
difficulty grasping some concept or set of material, please don’t be afraid to approach your lab 
instructor, as well as your lecture instructor! 

 Read all questions in this manual very carefully—students often exhibit a peculiar habit of 
giving an answer that has nothing to do with the question, and they lose points as a result. Don’t let 
that be you! 

 Key learning points are provided at the beginning of each lab. You should consider these 
as an outline (but not a complete list!) of principles, concepts, and skills you must master and on 
which you will be tested on your lab exams. 

 Blank note pages are provided at the end of each lab—you should use these to jot down 
important information that you learn during the labs because that information may well show up 
on your mid-term and final exams. They will be useful to you to study for those exams! 

 We hope that you find learning about geology in this lab course to be enjoyable and 
interesting. We are definitely interested in your thoughts about the labs in this manual so that we 
can improve them for future students, so please feel free to tell your lab instructor what you do and 
don’t like about the labs. In particular, let us know specific suggestions you have for improvements 
and/or clarifications!  

 In the meantime: welcome to the world of geology! (Yes, the pun was intended.) 

Dr. Jerry D. Harris 
Director of Paleontology and Associate Professor 

Dixie State College (or whatever we’ll end up being called) 
January, 2013 

 
 
 
 
 
 
 
 
 
 
A note concerning images used in this manual: As much as possible, photographs used in this 
manual were taken by the authors, and diagrammatic images are custom-designed by the authors. 
However, it should be assumed that all images are protected and cannot be copied or modified 
without the express permission of the person credited with the image. Every effort was made to use 
public domain images for the remaining images in this manual. If there are any concerns or 
questions please notify us in writing and we will be happy to remove the image from the next 
edition of the manual. 
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LAB #1 
THE SCIENTIFIC METHOD: 
A GEOLOGICAL EXAMPLE 
  

A geologist examines a conglomerate separating the Miocene Muddy Creek Formation below and a landslide 
block of the Mississippian Redwall Limestone on the west flank of the Beaver Dam Mountains, Utah. Photo 
by Jerry D. Harris. 
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 The purpose of this exercise is to provide you with first-hand experience with the scientific 
method as it pertains to geology. Geology, like most sciences, combines aspects of both historical 
science and experimental science: historical sciences must examine the end results of events that 
happened in the past and attempt to reconstruct those events; conversely, experimental sciences 
conduct experiments to see what the end results are. Because most of the events that have ever 
happened on Earth happened in the past, and left only end results to examine today, geology is a 
bit heavy on the historical aspect. However, for this exercise, you will use both observations of past 
events and experiments to formulate a hypothesis, modify it as necessary, and apply the hypothesis 
to a geologic problem. 
 
Key Learning Points: 
 

• The difference between a hypothesis and a theory. 
• Hypotheses are based on previous understanding of existing data and the application of 

logic—they are not guesses and do not involve guessing. 
• Hypotheses are adaptive and can (and should) change as new data are discovered. 
• Once supported by data, hypotheses about specific phenomena can be applied to construct 

new hypotheses about broader phenomena in space and time. 
 
 
 
This exercise is worth 50 points; point values for each question are given at the end of each 
question. 
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What Is A Hypothesis? 

 You have probable learned about the scientific method in your lecture, and/or in some 
past class. We needn’t go through it again here, but this lab focuses on the construction and 
subsequent refinement of a hypothesis. Hypotheses are, in many ways, the fundamental units in 
science—scientific investigation begins with a hypothesis, and the scientific method is specifically 
designed to work with hypotheses. Therefore, you need to understand exactly what a hypothesis is 
in order to do this lab effectively. 

 A hypothesis is a tentative, empirical (testable, falsifiable, and repeatable) statement about 
why something is the way it is, or why something happens the way it happens. Hypotheses are 
based on three things: 

(1) observations (including sight but also information from any other senses, as well as tools 
that detect things our senses cannot detect and translate information into a form our senses 
can detect), 

(2) any and all previous knowledge you have, and 
(3) logic. 

In short, a hypothesis proposes a reason why something is the way it is or why something happens 
the way it happens—the “something” is usually what has been observed, either by the person 
deriving the hypothesis or other people—and uses previous knowledge and logic as a basis for 
proposing the explanation. The explanation must be testable in a way that others can replicate it 
exactly, and the results of the test must have the possibility of demonstrating that the hypothesis is 
incorrect. Note that hypotheses are, by definition, tentative, meaning that they are neither 
supported nor refuted by much (if any) actual data (evidence). 

 That tentativeness is a huge part of what separates a hypothesis from a theory—despite the 
fact that you almost never hear “hypothesis” used in popular media, and hear “theory” instead, 
they are not different words for the same thing! In science1, a theory is a logic-based explanation 
for why something is the way it is, or why something happens the way it happens, but differs from a 
hypothesis in that it is supported by massive amounts of evidence. A theory has been researched 
by thousands and thousands of people, usually over many decades, or even centuries, and the 
results of all such research point to the same conclusion—the same explanation for why something 
is the way it is or why something happens the way it happens. That explanation is a theory. There’s 
no set point at which a hypothesis becomes a theory; usually, a theory encompasses hundreds of 
individual hypotheses—that is, a theory is kind of a blanket explanation that covers lots of 
individual instances, and those individual instances were tested as hypotheses. 

 Along with misusing “theory” when meaning “hypothesis,” people often confuse 
hypotheses (and, sometimes, even theories!) with guesses. But guesses are something altogether 
different again. Hypotheses are based on previous knowledge and logic, but guesses are not. For 

                                                           
1 The definitions given here for “hypothesis” and “theory” are the ones used in the “hard” sciences (geology, biology, 
chemistry, physics, etc.), but in the social sciences (e.g., psychology) and in education, the tendency is to use these two 
terms in the opposite way—they use “hypothesis” the way that the “hard” sciences use “theory,” and “theory” the way 
that the hard sciences use “hypothesis.” We have no idea why this is or how this difference came about, but the 
definitions in the “hard” sciences are the long-standing, traditional ones. 

Name:___________________________________________  Lab Section:________________________ 

READ & UNDERSTAND 
THIS SECTION BEFORE 

DOING THIS LAB! 
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example, I could ask you to guess what number I’m thinking of right now. Even if you knew me 
really well (= have some previous knowledge), none of what you know would enable you to 
determine what number I’m thinking of. Neither will logic, really. That’s where guesses come in—
guesses are literally random, basis-less attempts to find a solution. Hypotheses use previous 
knowledge, and therefore are not guesses (so don’t ever use the word “guess” when talking about a 
hypothesis!). 

 Also, many people confuse hypotheses with predictions. But these, too, are different, 
although related. Because a hypothesis is a (tentative) explanation for why something is the way it 
is, or why something happens the way it happens, a hypothesis enables you to make a prediction. 
You could predict that Y will result if X happens, but you’re able to make that prediction because 
you have a hypothetical explanation for the “why” (the process X). Hypotheses are not predictions, 
but hypotheses (and theories, too) allow predictions to be made. 

 Lastly—and this risks treading on some sensitive ground—hypotheses (and theories) are not 
beliefs. The words “belief” and “believe” have a couple of different definitions and uses, but what’s 
important here is the definition and use that essentially means “held to be true without needing any 
supporting evidence.” The key part of that is, of course, the “without needing any evidence”—that’s 
what differentiates a belief from a hypothesis, or indeed from anything scientific. Science always 
requires evidence to support a contention—it is, as part of the definition of “hypothesis” above 
notes, be empirical. Beliefs, in contrast, do not require evidence, and they don’t have to be 
testable. They don’t even have to be logical in any way. While scientists certainly have beliefs 
(they’re human beings, after all!), those beliefs don’t factor into their hypotheses. Hypotheses, and 
the scientific method, are generally belief-free. This is not to belittle beliefs in any way; this is 
simply to note that scientists do not “believe” that things are the way they are, or that things happen 
the ways that they happen, for some evidence-free reason; instead, they hypothesize (and, when 
appropriate, theorize) explanations for why things are the way they are because that’s what 
observations, previous knowledge, logic, and (in the case of theories) evidence supports. Just as you 
should not use the term “guess” when dealing with hypotheses (or theories), you should not use 
the terms “believe” or “belief” when dealing with hypotheses (or theories), either. 

 With this background understanding in mind, we can proceed to construct a basic 
hypothesis, and then refine it as we gather bits of data (information). 

 

STEP 1: Use what you already know to construct a logical hypothesis 

 Leaf fossils are relatively common, particularly compared to fossils of bones, shells, etc. 
This is, in large part, because lots of plants continually shed their old leaves and grow new ones; 
each shed leaf has the potential to become a fossil. In comparison, animals usually have only a 
single body (shell, skeleton, etc.) that they keep throughout their entire lives. However, fossil 
leaves—and especially those that preserve fine details—are generally only found in certain kinds of 
rocks, usually different rocks than those that preserve shells and bones. Think about your own 
experiences with leaves (particularly larger leaves from large bushes and trees)—what they look like 
on living plants, what they look like after they fall off of their plants or if their plants die, how 
durable leaves are, what happens to the under different conditions (and what those conditions are), 
etc. Use your previous observations and knowledge to construct a hypothesis below for question 
#1. 
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(1) Without seeing any specimens, and using only what you already know about leaves as a logical 
basis, what factors and conditions would be required to preserve a leaf as a fossil? Phrase your 
answer as a single sentence that begins “In order for a leaf to become a fossil…” followed by your 
list of events and/or conditions that must be met. (Please suppress the temptation to include overly 
general, tautological things such as “it must be in a rock” and “the leaf must fall off a plant.”) Don’t 
worry about how right or wrong you are (although misusing logic, or failing to explain your logic 
sufficiently, may cost you points!); you’ll be refining this hypothesis through the exercise—what’s 
important here is ensuring that you know how to construct a scientific hypothesis! (4 points) 
 
 
 
 
 
 
 
 
 
 
 
 
 
STEP 2: Observations 

 Examine the fossil leaves provided for you—you are welcome (strongly encouraged, 
actually!) to pick them up, touch them, examine them with the provided loupes, etc., as long as you 
are C A R E F U L with them. Examine both the fossils and the rocks they are in (not just the parts 
where the fossils are!) from many different angles as well as close up (use the loupes provided). 
Many different kinds of plants are represented here (all are land plants—only land plants have true 
leaves!), and the fossils are of many different ages, but the type of plant and the age are not 
important for our purposes here except to note that the fossil leaves you see here are from both 
tropical and temperate climates. All of these fossil leaves share some things in common, and these 
shared features have implications for how fossils of leaves form.  
 
 
IMPORTANT—understand these two things:  
(a) The fossils occur in rocks, but what are now rocks were loose materials at the time that the 

leaves fell into them and only later became rock—you will learn more about that process in the 
lectures. 

(b) Each fossil is in a piece of rock that was itself part of a larger body of rock, so each specimen 
used to have rock attached on all parts of it until someone broke it open and discovered the 
fossil. From the specimens, you cannot tell where in the larger body of rock the fossil used to be! 
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(2) Ignore the fossils on the rocks for the moment. Do the rock types in which the different fossils 
are preserved have any features in common? For example, examine the materials of which those 
rock types are composed, the colors of the rocks, the texture and feel of the rocks (ignoring any 
irregularities on the surfaces that are due to breakage of the rock or to preparation to expose the 
leaf fossil—feel the parts between the irregularities), the sizes of the components making up the 
rock, the arrangement of the components making up the rock, and many other things—you will 
probably want to examine the rocks close up and on multiple sides to get the best information 
about each one. If there are any features in common to all of the rocks, list them here. Note that 
this question does not ask you to speculate about either what rock types these are or where or how 
the rocks formed (3 points) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(3) Now ignore the rock types for the moment, but compare the fossils on all of the specimens. Do 
the materials of which the fossils are composed, across all the specimens, have anything in 
common? That is, do the materials of which the fossils are composed, and/or their styles of 
preservation, share any particular features or qualities between specimens? If so, list those 
commonalities here. (3 points) 
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STEP 3: Applicability of hypothesis to observations 

(4) Do any of the observations you made by examining the actual fossil leaves in questions #2–3 
match of the factors/conditions you specified in your hypothesis from question #1? In other words, 
did any of your observations match/account for things you listed in your initial hypothesis? If so, 
list them here. (2 points) 
 
 
 
 
 
 
 
(5) Conversely, are there any observations that you made by examining the actual fossil leaves that 
are not accounted for in your initial hypothesis? If so, list them here. (2 points) 
 
 
 
 
 
 
 
 
 
 
 
 
STEP 4: Revising the hypothesis 

(6) Now that you have new, additional data from examining the fossil specimens, you can refine 
your hypothesis from question #1 to incorporate it to formulate a narrower, more specific and 
detailed hypothesis. You may end up keeping or discarding some of your original hypothesis, and 
that’s OK. Phrase your revised hypothesis the same way that you did in question #1. (3 points) 
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STEP 5: Applying the hypothesis 

 Now you will be looking at some specimens of different rock types. Each specimen is 
simply a piece of a much larger body of rock, but should show the essential features of the type. 
Examine all the specimens of the 10 rock types by looking at them closely and from different 
angles, feeling them, etc., and read the bits of information about each one—the information on the 
signs will be critical to answering all the questions from this point on. Some of the types may be 
represented by more than one specimen—finding the things they have in common will help you 
understand the rock type better. (This is by no means an exhaustive sampling of rock types [!], and 
you will learn more about these rock types in lecture.) In particular, pay close attention to (a) how 
and where each rock forms, and (b) the compositions of these samples—what are the components 
of each one as far as you can tell (you are not expected to know what minerals are present in any of 
the specimens, but that’s not really relevant here anyway). None of these samples has any fossils of 
leaves in them, but think about each rock type from the perspective of whether or not you think 
leaf fossils could be found in it. Use what you learn from observing the specimens and reading the 
signs to answer the following questions. Your answers to questions #7–8 should account for all of 
the types you see here.  
 
(7) In which of these 10 rock types would you ever expect to find fossil leaves? List those types 
here and, for each type you list: (a) explain your reasoning as to why it would be suitable to 
preserve leaf fossils—what qualities/features of the rock type makes it a good candidate?, and (b) 
why would those qualities/features make fossilization of leaves more likely? Your answers should 
incorporate features of each rock type as well as qualities of the environments in which its 
components formed. (4 points) 
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(8) In which of these 10 rock types would you not expect to ever find fossil leaves? List those types 
here and, for each type you list: (a) explain your reasoning as to why it would be unsuitable to 
preserve leaf fossils—what qualities/features of the rock type makes it a poor candidate?, and (b) 
why would those qualities/features make fossilization of leaves unlikely? As before, your answers 
should incorporate features of each rock type as well as qualities of the environments in which its 
components formed. (4 points) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(9) Now go back and look at the fossil specimens again, and re-examine the rocks they are in. 
Which, if any, of the rock types that you listed in question #7 have the same specific features 
(components, arrangements of components, textures, etc.—ignore color, which is the absolute worst 
thing to use to identify and characterize rocks!) of the rocks containing the leaf fossils? If any, list 
those specific features here and list which rocks types have those features. (4 points) 
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STEP 6: Revising the hypothesis 

(10) Now that you have additional data from examining the rock-type specimens, and comparing 
them to the rocks that contain the fossils, you can further refine your hypothesis from question #6 
by incorporating it to formulate a narrower, more specific and detailed hypothesis. You may end 
up keeping or discarding some of your original hypothesis, and that’s OK. You may or may not 
specify particular rock types, but features of rocks and their formations may be important in your 
hypothesis! Phrase your revised hypothesis the same way that you did in question #1. (3 points) 
 
 
 
 
 
 
 
 
 
 
 
 
 
STEP 7: Testing the hypothesis 

 At this station, you will conduct some experiments to gauge how correct your hypothesis is. 
At this station are several bowls of sediments of different grain sizes (coarse to fine) and different 
degrees of saturation with a liquid, as well as some modern leaves—the leaves are not necessarily 
from the same kinds of plants you saw in the fossils, but that’s OK. Impress the leaves (the sides 
with the big veins facing down) into the sediments firmly  but gently. Press as much of each leaf in 
as possible—you may need to hold down parts of the leaf with one hand while pressing with the 
other. Then, as carefully as possible, remove (by lifting it straight up or carefully peeling it away 
from where it contacted the sediment) the leaves to examine how they interacted with the different 
sediments. When you are finished using each leaf and sediment combination, erase any 
impressions you made from the sediment and clean the leaf off so that the next students can 
conduct their own experiments. 
 
(11) Which, if any, sediment type(s) (gravel, sand, mud) and consistency(s) (dry, wet) was/were able 
to capture and preserve features of a leaf with the most similar amount of detail as the actual fossils 
that you examined in Step 2? (3 points) 
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(12) For the sediment type(s) you listed in question #11, what characteristics enabled it/them to 
capture the features of the leaf in the most detail, and why would those particular characteristics be 
conducive to preserving those details? (4 points) 
 
 
 
 
 
 
 
 
 
 
(13) Imagine that the sediments in each of the tubs turned into rock. Which, if any, of the rock 
types you examined previously (in Step 5) would each of these sediment types (gravel, sand, mud) 
match? (3 points) 
 
 
 
 
 
 
 
 
 
(14) Did the sediment type(s) and consistency(s) you listed in question #11 capture all of the 
features of the leaves you saw in the fossils? If not, which features of the leaves were not captured, 
and what does that tell you about the fossilization of leaves that was not replicated in your 
experiments at this station? HINT: one (but not  necessarily the only!) thing to think about is the 
colors of the fossils you saw vs. the “fossils” you made in the sediments—what might that tell you?) 
(2 points) 
 
 
 
 
 
 
 
 
 
 
 
 
  



 12 

(15) Do any of the observations you made from the sediment experiments in questions #11–14 
match anything you specified in your hypothesis from question #10? In other words, did any of 
your observations match/account for things you listed in your most recent hypothesis that would be 
necessary to preserve a leaf fossil? If so, list them here. (2 points) 
 
 
 
 
 
 
 
 
 
 
STEP 8: Revising the hypothesis 

(16) Now that you have additional data from the sediment experiments, you can further refine your 
hypothesis from question #10 to incorporate it. By now, your hypothesis should have some very 
specific (not general!) factors/conditions in it to formulate a narrower, more specific and detailed 
hypothesis. You may end up keeping or discarding some of your original hypothesis, and that’s 
OK. Phrase your revised hypothesis the same way that you did in question #1. (3 points) 
 
 
 
 
 
 
 
 
 
 
 
 
 
STEP 9: Broader implications 

 Now you should have a hypothesis that accounts for many different factors—rock types and 
the key components in those rocks , water conditions, etc.—that provides a possible explanation for 
the conditions in which fossil leaves form. Now think about different environments in the real 
world—you can now use your hypothesis to make inferences about ancient environments! In your 
considerations, think about things like any transport mechanisms that brought the leaves and the 
rock-forming materials together (HINT: go back and re-read the signs with the rock type 
samples!), proximity to leaf-bearing plants, etc. Given what you now know about factors/conditions 
necessary to preserve leaf fossils, and the characteristics of the materials that make up the rocks in 
which the fossils you saw were preserved, think about where the conditions would exist necessary 
to bring together leaves and the rock materials necessary for leaf fossilization. 
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(17) In what kind(s) of environment(s) do the conditions necessary to form leaf fossils exist? Note 
that this question asks where—specify environment types (e.g., “beach,” “desert”) and physical 
places (e.g., “mountain tops,” “grasslands”); don’t just use vague descriptive terms (e.g., “wet,” “has 
lots of plants”). Then, specify what qualities about those environments create the conditions 
suitable to form fossil leaves. (5 points) 
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NOTES FOR SCIENTIFIC METHOD 
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LAB #2 
GEOLOGIC HAZARDS 
  

Buildings toppled because of liquefaction during a 1964 
earthquake in Niigata, Japan. Photo by T.L. Youd, from the U.S. 
Geological Survey Photographic Library (ID 453). 
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 The purpose of this exercise is to provide you with an understanding of many different 
kinds of geologic hazards, emphasizing the prevalence and risks in the St. George–Hurricane area. 
In addition, this exercise will provide you with some experience in reading maps, particularly ones 
that outline the risks of various kinds of geologic hazards in the St. George–Hurricane area. 
 
Key Learning Points: 
 

• What a geologic hazard is. 
• The root causes of, and conditions necessary for geologic hazards due to: 
 earthquakes, 
 flooding 
 mass wasting, 
 soil types, 
 wind, and 
 groundwater. 

• The potentials for these kinds of geologic hazards in the St. George–Hurricane area. 
• How to mitigate (reduce the potential for damage of) these hazards. 
• How to determine the potential for a geologic hazard anywhere in the U.S. 
• Basic map-reading skills. 

 
This exercise is worth 90 points; point values for each question are given at the end of each 
question. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For all questions in this exercise that involve reading and learning material 
from the provided maps, your answers must be in your own words. Any 
answers that are copied verbatim from the provided maps will not count 

for credit! 
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 A geologic hazard is a geologic event that can endanger human lives and property. 
Earthquakes are probably the most familiar and well-known geologic hazard; volcanic eruptions 
are a close second. However, even in areas not prone to either of these, less familiar and less 
famous geologic hazards can still pose great risks. In monetary terms, these other hazards cost 
people (and governments) far more money each year than either earthquakes or volcanic 
eruptions, and many are not covered by typical home-owner’s insurance policies! 

 Washington County is susceptible to both earthquakes and volcanic eruptions, but the far 
more serious, more numerous, and more frequent hazards have little or nothing to do with either 
one. These include flooding, mass wasting, problematic soils, and even wind and groundwater. 
Geologists with the Utah Geological Survey (UGS) have been charged with assessing the risks for 
various hazards around Utah and have produced geologic hazard maps; the ones for the St. 
George–Hurricane area have been recently redone to reflect up-to-date hazard risks. You will be 
reading some of these maps in this lab and using them to both learn more about geologic hazards 
and answer some questions about them. If you plan to live somewhere in Utah (including 
Washington County) in the future and want to determine what hazards are risks for an area in 
which you want to live, you can consult these maps on-line for free at 
http://geology.utah.gov/maps/geohazmap/index.htm. We will not be examining all possible hazards 
in this lab—only some of the more important (and potentially dangerous or damaging) ones. You 
can find maps for other types of hazards at the link above, and I encourage you to look at them, as 
well! 

 

EARTHQUAKE HAZARDS 

 Earthquakes occur all over the world, often without warning. They can have far-reaching 
effects on humans and on the Earth’s surface. As you will learn later in your lectures, the term 
“earthquake” refers to the vibrations created by movement along a fault or by magma moving 
underground (sometimes to the surface through a volcano). Earthquakes can even be man-made, 
induced by explosions or by humans injecting fluids into faults, thereby lubricating them. The 
vibrations can be violent and cause widespread damage and injury, or they may not even be 
noticeable. Small, localized earthquakes may not cause noticeable damage; in contrast, large 
earthquakes famously can cause destruction over broad areas and be felt thousands of miles away.  

 Earthquakes caused by movement along interplate (between tectonic plates) faults are the 
most destructive. The boundaries (margins) of tectonic plates—about which you will also learn 
later—are active fault zones, and are where most (≈90%) earthquakes occur. In fact, the locations of 
earthquakes, and the kinds of ruptures they produce, help define the boundaries of tectonic plates. 
The remaining (≈10%) earthquakes occur on intraplate (within plate) faults—in the St. George–
Hurricane area, several intraplate faults are known, and some have experienced earthquakes since 
the area was settled in the 1850s (and probably many more since the first Native Americans settled 
the area thousands of years earlier!). 

 We tend to think of earthquake damage as the result of the ground shaking, but in many 
cases, the most damage may be caused by other effects, such as surface fault ruptures and 
liquefaction. By understanding these effects, and how they affect human lives and property, we can 
lessen their impacts, even though we cannot prevent them from happening.  

Name:___________________________________________  Lab Section:________________________ 

http://geology.utah.gov/maps/geohazmap/index.htm
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(1) Find and study the Surface Fault Rupture Hazard map, and read the text that accompanies it. 

 
(a) What is surface faulting (rupturing), what causes it, and how is it a hazard to humans and/or 

property? (2 points) 
 
 
 
 
 
 
 
 
 

(b) What is the best way to reduce the effects of this hazard, and, in cases where implementing 
that solution is not possible, what are some other ways to reduce the effects? (2 points) 

 
 
 
 
 
 
 
 

(c) Examine the map and find the areas at greatest risk of this hazard (HINT: read the map 
and its legend carefully and completely to find this!). Does the distribution of areas that are 
at greatest risk have a pattern—that is, do they all occur in the same kind(s) of place(s) (even 
if each of those places has its own name), and do those places have any relationship to 
particular kinds of geologic and/or topographic structures/features (e.g., mountains, valleys, 
plains, etc.)? If they do not have a pattern, specify some of the major high-risk areas. (4 
points). 

 
 
 
 
 
 
 

(d) Find where your home is and describe the potential for this hazard at that location—
specifically, if there is a relatively high hazard, what geologic/topographic feature(s), rock 
formations, etc. at that location create the hazard there? (2 points) 
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(2) Find and study the Liquefaction Hazard map, and read the text that accompanies it. 
 

(a) What is liquefaction, what factors are involved, and what causes it? (2 points) 
 
 
 
 
 
 
 
 

(b) How does liquefaction cause property damage? (2 points) 
 
 
 
 
 
 
 
 

(c) What is the best way to reduce the effects of this hazard, and, in cases where implementing 
that solution is not possible, what are some other ways to reduce the effects? (2 points) 

 
 
 
 
 
 
 
 
 

(d) Examine the map and find the areas at greatest risk of this hazard. Does the distribution of 
areas that are at greatest risk have a pattern—that is, do they all occur in the same kind(s) of 
place(s) (even if each of those places has its own name), and do those places have any 
relationship to particular kinds of geologic and/or topographic structures/features (e.g., 
mountains, valleys, plains, etc.)? (HINT: both the text and the map will be useful in 
answering this question!) If so, explain why this hazard has that relationship. If they do not 
have a pattern, specify some of the major high-risk areas. (4 points) 

 
 
 
 
 
 
 
 

(question continues on the next page)  
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(e) Find where your home is and describe the potential for this hazard at that location—
specifically, if there is a relatively high hazard, what geologic/topographic feature(s), rock 
formations, etc. at that location create the hazard there? (2 points) 

 
 
 
 
 
 
 
SURFACE WATER HAZARD: FLOODING 

 Floods are among the most common geologic hazards in the U.S.: they occur in every state 
and cost upward of $6 billion annually. On average, most river systems flood every year or two, 
although the magnitude of each flood can vary widely. A flood occurs when water in a stream 
leaves the confines of its channel and flows outward onto its surrounding floodplain—as you will 
learn later in lecture, rivers create their own floodplains by flooding repeatedly. Three types of 
floods can be recognized: 

• regional floods—these rise and ebb gradually and last for weeks or months; 
• flash floods—these occur suddenly and last only hours; and 
• sheetfloods—these are broad expanses of moving water produced by storms that spread as 

thin, continuous, and relatively uniform “films” over large areas for hours. 

All of these types are dangerous and capable of inflicting substantial damage to homes, property, 
and infrastructure, and all can kill. Each year, an average of 140 people are killed by floods in the 
U.S. 

(3) Find and study the Flood Hazard map, and read the text that accompanies it. 
 

(a) How does flooding cause property damage, and how do humans make the problem worse? 
(2 points) 

 
 
 
 
 
 
 
 

(b) What is the best way to reduce the effects of this hazard, and, in cases where implementing 
that solution is not possible, what are some other ways to reduce the effects? (2 points) 

 
 
 
 
 
 

(question continues on the next page)  
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(c) Examine the map and find the areas at greatest risk of this hazard (zones AE and A). Does 
the distribution of areas that are at greatest risk have a pattern—that is, do they all occur in 
the same kind(s) of place(s) (even if each of those places has its own name), and do those 
places have any relationship to particular kinds of geologic and/or topographic 
structures/features (e.g., mountains, valleys, plains, etc.)? If so, explain why this hazard has 
that relationship. If they do not have a pattern, specify some of the major high-risk areas. (4 
points) 

 
 
 
 
 
 
 
 
 

(d) Find where your home is and describe the potential for this hazard at that location—
specifically, if there is a relatively high hazard, what geologic/topographic feature(s), rock 
formations, etc. at that location create the hazard there? (2 points) 

 
 
 
 
 
 
MASS WASTING HAZARDS 

 Geologists refer to gravity-driven, down-slope movements of earth materials as “mass 
wasting” events. Colloquially, the media usually refers to mass wasting events as “landslides,” but 
the term “landslide” is a broad, blanket term for what are actually many different kinds of gravity-
driven events, such as earthflows, mudflows, and slumps. You will learn more about mass wasting 
events later in your lectures, and you will examine some mass wasting events in a later lab.  
 
(4) Find and study the Landslide Hazard map, and read the text that accompanies it. 
 

(a) Read the map’s definition of a “landslide.” What is the force that governs and controls 
movement of a landslide? (1 point) 

 
 
 
 

(b) Given your answer to part (a), what role does water play in a landslide? (2 points) 
 
 
 
 

(question continues on the next page)  
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(c) How do landslides cause disruption and damage to man-made structures? (2 points) 
 
 
 
 
 
 
 

(d) What is the best way to reduce the effects of this hazard, and, in cases where implementing 
that solution is not possible, what are some other ways to reduce the effects? (2 points) 

 
 
 
 
 
 
 
 

(e) What is the full name of the rock unit (layer) that is responsible for Susceptible Category 
B, which is the highest risk for landslides (other than existing, already-moving landslides)? 
If you are unfamiliar with the abbreviations used on the map, ask your teacher. (1 point) 

 
 
 
 

(f) What substance in this rock unit causes it to be at such high risk for this hazard (what is 
locally called “blue clay”) and why (and when) is it a problem? (2 points) 

 
 
 
 
 
 

(g) Examine the map and find the areas at greatest risk of this hazard. Given your answer to 
question #4e, does the distribution of areas that are at greatest risk have a pattern—that is, 
do they all occur in the same kind(s) of place(s) (even if each of those places has its own 
name), and do those places have any relationship to particular kinds of geologic and/or 
topographic structures/features (e.g., mountains, valleys, plains, etc.)? If so, explain why this 
hazard has that relationship. If they do not have a pattern, specify some of the major high-
risk areas. (4 points) 

 
 
 
 
 
 

(question continues on the next page)  
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(h) Find where your home is and describe the potential for this hazard at that location—
specifically, if there is a relatively high hazard, what geologic/topographic feature(s), rock 
formations, etc. at that location create the hazard there? (2 points) 

 
 
 
 
 
 
 
(5) Find and study the Rockfall Hazard map, and read the text that accompanies it. 
 

(a) What is a rockfall, and what are three rock types (not the names of the units from which 
the rocks come—however, the names of some of the units tell you what kind of rock they 
are made of!) are the primary source of risk in the St. George–Hurricane area? (2 points) 

 
 
 
 
 
 
 
 

(b) What is the best way to reduce the effects of this hazard, and, in cases where implementing 
that solution is not possible, what are some other ways to reduce the effects? (2 points) 

 
 
 
 
 
 
 

(c) Examine the map and find the areas at greatest risk of this hazard. Does the distribution of 
areas that are at greatest risk have a pattern—that is, do they all occur in the same kind(s) of 
place(s) (even if each of those places has its own name), and do those places have any 
relationship to particular kinds of geologic and/or topographic structures/features (e.g., 
mountains, valleys, plains, etc.)? If so, explain why this hazard has that relationship. If they 
do not have a pattern, specify some of the major high-risk areas. (4 points) 

 
 
 
 
 
 
 
 

(question continues on the next page)  
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(d) Find where your home is and describe the potential for this hazard at that location—
specifically, if there is a relatively high hazard, what geologic/topographic feature(s), rock 
formations, etc. at that location create the hazard there? (2 points) 

 
 
 
 
 
 
 
 
 
PROBLEM SOIL HAZARDS 

 Problem soils are some of the most widely distributed and costly of geologic hazards. 
These soils are subject to changes in volume and/or compaction in response to wetting and drying. 
Although most people do not think of soils as potential hazards—probably because they do not 
produce “thrilling” events, such as earthquakes do, that cause catastrophic damage on large scales—
annually, expansive soils comprise the most expensive of all geologic hazards, costing several 
billions of dollars. 

• Expansive soils (and rocks) are unconsolidated (loose) sediments that contain particular 
clay minerals (such as smectite) that swell when wet—sometimes by an additional 10% of 
their normal, dry volumes!—and shrink when drying out. After dry rot (which is not a 
geologic hazard), expansive soils are the most common cause of property damage in the 
U.S. 

• Collapsible soils are sediments that lose strength (the ability to support weight) under 
various conditions. The most common type of collapsible soil, called hydrocompactive soil, 
is common in semi-arid and arid climates of the American Southwest. In such soils, 
individual sediment grains are stacked atop one another, and not compacted as tightly as 
they could be. When wetted, the agents that prevent individual grains from slipping soften 
or dissolve, allowing grains to shift and compact; the entire body of sediment thus loses 
volume. 

• Gypsiferous soils contain the evaporite mineral gypsum (CaSO4), which dissolves in water. 
The introduction of water into a gypsiferous soil (re)dissolves some of the gypsum and 
carries it away as groundwater. This causes a loss of overall soil volume, similar to what 
happens with hydrocompactive soils. Occasionally, underground solution cavities can 
develop where massive amounts of gypsum dissolve, and if these cavities near the surface, 
the ground can collapse into a sinkhole. (A similar phenomenon more commonly occurs 
in areas overlying bedrock of limestone.) Risk of problems from gypsiferous soils is 
especially strong when large amounts of water are introduced artificially, such as by 
irrigation for crops, landscaping, and wastewater disposal systems. 
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(6) Find and study the Expansive Soil and Rock Susceptibility map, and read the text that 
accompanies it. 
 

(a) How does the map define the term “expansive soil and rock”? (2 points) 
 
 
 
 
 
 
 

(b) How does expansive soil and rock cause damage to man-made structures? (2 points) 
 
 
 
 
 
 

(c) What is the best way to reduce the effects of this hazard, and, in cases where implementing 
that solution is not possible, what are some other ways to reduce the effects? (2 points) 

 
 
 
 
 
 
 
 
 
 

(d) Examine the map and find the areas at greatest risk of expansive soil and the areas at 
greatest risk for expansive rock. Does the distribution of areas that are at greatest risk of 
each of these areas have a pattern—that is, do they all occur in the same kind(s) of place(s) 
(even if each of those places has its own name), and do those places have any relationship 
to particular kinds of geologic and/or topographic structures/features (e.g., mountains, 
valleys, plains, etc.)? If they do not have a pattern, specify some of the major high-risk 
areas. (4 points) 

 
 
 
 
 
 
 
 
 

(question continues on the next page)  
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(e) Find where your home is and describe the potential for this hazard at that location—
specifically, if there is a relatively high hazard, what geologic/topographic feature(s), rock 
formations, etc. at that location create the hazard there? (2 points) 

 
 
 
 
 
 
 
 
 
(7) Find and study the Gypsiferous Soil and Rock Susceptibility map, and read the text that 
accompanies it. 
 

(a) How do gypsiferous soils and rocks become an adverse construction condition, and how 
do they cause damage to man-made structures? (2 points) 

 
 
 
 
 
 
 
 
 
 
 

(b) What is the best way to reduce the effects of this hazard, and, in cases where implementing 
that solution is not possible, what are some other ways to reduce the effects? 2 points) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

(question continues on the next page)  
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(c) Examine the map and find the areas at greatest risk of gypsiferous soil and the areas at 
greatest risk of gypsiferous rock. Does the distribution of areas that are at greatest risk of 
each of these areas have a pattern—that is, do they all occur in the same kind(s) of place(s) 
(even if each of those places has its own name), and do those places have any relationship 
to particular kinds of geologic and/or topographic structures/features (e.g., mountains, 
valleys, plains, etc.)? If they do not have a pattern, specify some of the major high-risk 
areas. (4 points) 

 
 
 
 
 
 
 
 
 
 

(a) Find where your home is and describe the potential for this hazard at that location—
specifically, if there is a relatively high hazard, what geologic/topographic feature(s), rock 
formations, etc. at that location create the hazard there? (2 points) 

 
 
 
 
 
 
 
 
 
 
SHALLOW GROUNDWATER HAZARDS 

 Shallow groundwater hazards occur when sufficiently shallow water tables (the tops of the 
masses of water in the ground) are cyclically or persistently above the level of man-made structures 
that are underground, resulting in negative impacts to the structures. 
 
(8) Find and study the Shallow Groundwater Susceptibility map, and read the text that 
accompanies it. 
 

(a) What kinds of problems does shallow groundwater create/cause, and  how do these 
problems affect construction of subsurface structures? (2 points) 
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(b) What is the best way to reduce the effects of this hazard, and, in cases where implementing 
that solution is not possible, what are some other ways to reduce the effects? (2 points) 

 
 
 
 
 
 
 
 
 
 

(c) Examine the map and find the areas at greatest risk of naturally wet, poorly drained, and 
moderately to freely draining soils greatest and that must be considered from a 
groundwater perspective. Does the distribution of areas that are at greatest risk have a 
pattern—that is, do they all occur in the same kind(s) of place(s) (even if each of those 
places has its own name), and do those places have any relationship to particular kinds of 
geologic and/or topographic structures/features (e.g., mountains, valleys, plains, etc.)? If 
they do not have a pattern, specify some of the major high-risk areas. (4 points) 

 
 
 
 
 
 
 
 
 
 

(d) Find where your home is and describe the potential for this hazard at that location—
specifically, if there is a relatively high hazard, what geologic/topographic feature(s), rock 
formations, etc. at that location create the hazard there? (2 points) 
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NOTES FOR GEOLOGIC HAZARDS 
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LAB #3 
 
 
 
 
 
 
MINERALS  

Mesolite (Na2Ca2Al6Si9O30•8H2O) crystals from Poona, India, on display at the Denver Museum of Nature and 
Science. Photo by Jerry D. Harris. 
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 The purposes of this exercise are: 

• To provide you with first-hand experience with samples of several different minerals. 
During the course of this lab, you will gain some experience and better understanding of 
the characteristics that differentiate one mineral from another and the basic ways in which 
geologists determine these characteristics.  

• To give you an appreciation for how minerals are used to create and sustain the 
technologies that form the base of our modern society. 

• To give you an appreciation for many minerals (or elements extracted from minerals) that 
are used by humans, including you, which is why understanding them, and being able to 
identify them, is important to geologists. 

 
Key Learning Points: 
 

• Characterizing and identifying mineral samples using color, luster, hardness, cleavage, and 
streak. 

• The basic classification system (silicates and non-silicates, and subgroups of the latter) used 
for minerals. 

• Recognizing that minerals have economic and technological importance in everyday human 
lives. 

 
 
 
This exercise is worth 120 points; point values for each question are given at the end of each 
question. 
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NON-SILICATE MINERAL CLASSIFICATION + EXAMPLES 
 

GROUP  EXAMPLE  FORMULA 

Oxides 
(O, O2, O3, O4) 

 chromite Fe3Cr2O4 
 corundum Al2O3 
 hematite Fe2O3 
 ilmenite FeTiO3 
 magnetite Fe3O4 
 rutile TiO2 
 uraninite UO2 
 water ice H2O 

Hydroxides 
(OH) 

 gibbsite Al(OH)3 
 goethite FeO(OH) 
 limonite FeO(OH)•nH2O 

Carbonates 
(CO3) 

 aragonite CaCO3 
 azurite Cu3(CO3)2(OH)2 
 calcite CaCO3 
 dolomite CaMg(CO3)2 
 malachite Cu2CO3(OH)2 
 rhodochrosite MnCO3 
 siderite FeCO3 

Phosphates 
(PO4) 

 apatite Ca5(PO4)3(F, Cl,OH) 
 monazite (Ce,La,Y,Th)PO4 
 turquoise CuAl6(PO4)4(OH)8•5H2O 

Vanadates (VO4)  carnotite K2(UO2)2(VO4)2•3H2O 
 vanadinite Pb5(VO4)3Cl 

Arsenates (AsO4)  annabergite Ni3(AsO4)2•8H2O 

Sulfates 
(SO4) 

 anhydrite CaSO4 
 barite BaSO4 
 celestite SrSO4 
 gypsum CaSO4•2H2O 

Sulfides 
(S, S2, S3) 

 bornite Cu5FeS4 
 chalcopyrite CuFeS2 
 cinnabar HgS 
 galena PbS 
 orpiment As2S3 
 pyrite FeS2 
 sphalerite ZnS 
 stibnite Sb2S3 

Halides 
(F, Cl, Br, I) 

 fluorite CaF2 
 halite NaCl 
 sylvite KCl 

Native Elements 

 copper Cu 
 diamond C 
 gold Au 
 graphite C 
 platinum Pt 
 silver Ag 
 sulfur S, S8 
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LUSTER DESCRIPTIONS AND EXAMPLES 
 
NOTE: Some minerals can span more than one luster category (vitreous–resinous, metallic–adamantine, resinous–
earthy, etc.). 
 
LUSTER DESCRIPTION NON-MINERAL EXAMPLE MINERAL EXAMPLES 

adamantine 
(brilliant) 

 brilliant and glaringly 
reflective, like a cut diamond 

 transparent/translucent 
 not like a metal (see metallic, 

below) 
 can be like an extremely 

reflective version of resinous 
or vitreous (see below)           

dull 
(earthy) 

 unremarkable, unreflective 
(except possibly on cleavage 
surfaces) 

 no other luster 

          

greasy 

 dully reflective 
 as if dipped in clear cooking 

oil and thus coated in thin 
sheen of oil or grease 
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metallic 

 shiny and highly reflective like 
polished metal 

 opaque, not 
transparent/translucent 

 not necessarily silvery! 

  

  

pearly  iridescent, many (usually pale) 
colors, as a pearl 

  

resinous 

 plastic- (resin-), amber-, or 
honey-like 

 moderately reflective 
 may or may not be 

transparent/translucent 
 if extremely reflective and 

transparent/translucent, see 
adamantine (above)        

silky 

 fine, fibrous structure 
 may appear vaguely furry or 

fuzzy 
  moderately–dully reflective 
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vitreous 
(glassy) 
 
most 
common 
luster (70% of 
minerals) 

 similar to glass 
 highly reflective 
 often transparent/translucent 

but can be opaque and dark 
 not necessarily colorless 
 if extremely reflective and 

transparent/translucent, see 
adamantine (above) 

 

    

waxy  like candle wax (paraffin) 
 slightly, dully reflective 

             
 
 
 
 
 
 
 
 
 
 
 
 
Photo credits (from left to right per category): adamantine: http://www.professionaljeweler.com/archives/articles/1998/jul98/0798dg.html, http://www.minerals.net/mineral_glossary/adamantine.aspx, and 
http://www.minfind.com/mineral-10615.html; dull: http://0.tqn.com/d/geology/1/0/w/y/shaleberry.jpg, http://comp.uark.edu/~sboss/vrockbag.htm, and http://en.wikipedia.org/wiki/File:KaolinUSGOV.jpg; 
greasy: http://pizzaisdelicious.com/wp-content/uploads/2009/02/greasy_01.jpg, http://diamond1872.blogspot.com/, and http://www.minerals.net/mineral_glossary/greasy_luster.aspx; metallic: 
http://www.calibratedsps.com/screenprint/screen-printing-supplies/transfer-media/transfer-foils/metallic-heat-transfer-foil-12-inch-roll.html, http://organicconnectmag.com/wp/wp-
content/uploads/2011/11/pyrite.jpg, and http://jillschneiderman.files.wordpress.com/2010/02/copper1.jpg; pearly: http://www.lincoln.kyschools.us/images/Buttons/pearl.jpg and 
http://www.cs.cmu.edu/~adg/images/minerals/psilicates/talc.jpg; resinous: http://hyperexperience.com/wp-content/uploads/2008/03/humidifier.jpg, 
http://o.quizlet.com/i/PeUmQ2YZEb4YoPuvE6towg_m.jpg, and http://upload.wikimedia.org/wikipedia/commons/thumb/2/2e/Sulfur.jpg/210px-Sulfur.jpg; silky: 
http://www.libertysilk.biz/ProImg/2612200809/royal%20purple%20satin%20silk.jpg, http://nevada-outback-gems.com/mineral_information/Chrysotile_asbestos03.jpg, and 
http://www.crystalclassics.co.uk/minerals/s_6195.jpg; vitreous: http://recycleforlewisham.files.wordpress.com/2011/02/glass-drinking.jpg, http://img2.etsystatic.com/000/0/5264348/il_570xN.242326374.jpg, 
http://www.mineralminers.com/html/phantom_quartz_crystal.htm, http://www.thunderhealing.com/rock/orthoclase.jpg,  and http://0.tqn.com/d/geology/1/0/y/C/1/tourmaline500.jpg ; waxy: 
http://bloximages.newyork1.vip.townnews.com/phillyburbs.com/content/tncms/assets/v3/editorial/1/78/178cf2da-3d3c-11e1-b2c8-0019bb30f31a/4f0f0cea096fa.image.jpg, 
http://www.minfind.com/mfthumbs/390_350_20660973974fbcfbe3748ae.jpg, and http://www.minerals.net/mineral_glossary/waxy_luster.aspx.  

http://www.professionaljeweler.com/archives/articles/1998/jul98/0798dg.html
http://www.minerals.net/mineral_glossary/adamantine.aspx
http://www.minfind.com/mineral-10615.html
http://0.tqn.com/d/geology/1/0/w/y/shaleberry.jpg
http://comp.uark.edu/~sboss/vrockbag.htm
http://en.wikipedia.org/wiki/File:KaolinUSGOV.jpg
http://pizzaisdelicious.com/wp-content/uploads/2009/02/greasy_01.jpg
http://diamond1872.blogspot.com/
http://www.minerals.net/mineral_glossary/greasy_luster.aspx
http://www.calibratedsps.com/screenprint/screen-printing-supplies/transfer-media/transfer-foils/metallic-heat-transfer-foil-12-inch-roll.html
http://organicconnectmag.com/wp/wp-content/uploads/2011/11/pyrite.jpg
http://organicconnectmag.com/wp/wp-content/uploads/2011/11/pyrite.jpg
http://jillschneiderman.files.wordpress.com/2010/02/copper1.jpg
http://www.lincoln.kyschools.us/images/Buttons/pearl.jpg
http://www.cs.cmu.edu/~adg/images/minerals/psilicates/talc.jpg
http://hyperexperience.com/wp-content/uploads/2008/03/humidifier.jpg
http://o.quizlet.com/i/PeUmQ2YZEb4YoPuvE6towg_m.jpg
http://upload.wikimedia.org/wikipedia/commons/thumb/2/2e/Sulfur.jpg/210px-Sulfur.jpg
http://www.libertysilk.biz/ProImg/2612200809/royal%20purple%20satin%20silk.jpg
http://nevada-outback-gems.com/mineral_information/Chrysotile_asbestos03.jpg
http://www.crystalclassics.co.uk/minerals/s_6195.jpg
http://recycleforlewisham.files.wordpress.com/2011/02/glass-drinking.jpg
http://img2.etsystatic.com/000/0/5264348/il_570xN.242326374.jpg
http://www.mineralminers.com/html/phantom_quartz_crystal.htm
http://www.thunderhealing.com/rock/orthoclase.jpg
http://0.tqn.com/d/geology/1/0/y/C/1/tourmaline500.jpg
http://bloximages.newyork1.vip.townnews.com/phillyburbs.com/content/tncms/assets/v3/editorial/1/78/178cf2da-3d3c-11e1-b2c8-0019bb30f31a/4f0f0cea096fa.image.jpg
http://www.minfind.com/mfthumbs/390_350_20660973974fbcfbe3748ae.jpg
http://www.minerals.net/mineral_glossary/waxy_luster.aspx
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(1) Determine the identities of the eight unlabeled, unidentified mineral specimens provided by: 

• determining various characteristics of each specimen, and then  

• matching those sets of characteristics with an entry on a table of different minerals and their 
known attributes. 

To help guide you through this identification process, here’s a simple flowchart to navigate the 
tables on the pages that follow:  

 
 
Note that a classification table of non-silicate minerals is provided for you on the previous pages—
they will be helpful to you for this and many other questions in this lab. 
 
 On the tables that you will fill in below, circle the correct number or term for the criteria 
that have options given; for the other criteria, write in the characteristic. (7 points each; 56 points 
total) 

Luster 

Metallic: see 
Luster Table 

Non-metallic 

Hardness 
< 5.5 

Weak (white 
and/or faint) 

streak 
Cleavage 

None: see 
Cleavage 
Table #1 

1+ : see 
Cleavage 
Table #2 Strongly colored 

streak: see Streak 
Table 

Hardness 
≥ 5.5 

Cleavage 

None: see 
Cleavage 
Table #3 

1+ : see 
Cleavage 
Table #4 
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LUSTER TABLE 
 

Specimen Color Hardness Streak Cleavage Other 
Mineral Name & 
Formula 

bronze-brown < 5.5 black 1 (rarely 
visible) 

commonly has purple-ish, 
iridescent tarnish 

bornite 
Cu5FeS4 

black, brownish black < 5.5 black, greenish black, 
brownish black, gray 

none luster may be almost non-
metallic; weakly magnetic 

chromite 
Fe3Cr2O4 

deep, dark, golden yellow, 
greenish yellow 

< 5.5 black, greenish black, 
brownish black, gray 

none may occur as coating on other 
mineral/rocks 

chalcopyrite 
CuFeS2 

silvery gray < 5.5 black, greenish or 
brownish black, gray 

3 (at 90°) very heavy galena 
PbS 

dark brown, black < 5.5 yellowish brown none may occur as rounded masses 
with radiating fibers 

goethite (pronounced 
GER-tite) 
FeO(OH) 

dark gray, blackish < 5.5 dark gray, blackish 1 (rarely 
visible) 

greasy feel, rubs off easily on 
paper and fingers 

graphite 
C 

gray, blackish, faintly 
reddish or red bands 

≥ 5.5 rust red, brownish red none may be faintly sparkly hematite 
Fe2O3 

dark gray, black ≥ 5.5 black none moderately magnetic; may be 
faintly sparkly 

magnetite 
Fe3O4 

copper, brownish, may 
have green or brown 
coating 

< 5.5 copper, red none malleable (bendable, 
deformable) 

native copper 
Cu 

bright, brassy yellow > 5.5 greenish black, black none fairly heavy; crystals may be 
cubes or dodecahedrons 

pyrite 
FeS2 

light yellow, yellowish 
brown, silvery, black 

< 5.5 yellow, brown 6 (almost 
never 
visible) 

may smell faintly like rotten 
eggs 

sphalerite 
ZnS 
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STREAK TABLE 
 
Streak Specimen Color Hardness Cleavage Luster Other Mineral Name & 

Formula 
blue intense, dark 

blue 
< 5.5 none vitreous commonly occurs as masses of 

tiny crystals, often with 
malachite 

azurite 
Cu3(CO3)2(OH)2 

dark gray, 
blackish 

dark gray, 
blackish 

< 5.5 1 (but 
rarely 
visible) 

greasy–pearly, vaguely 
metallic 

greasy feel, gets on paper and 
fingers 

graphite 
C 

rust red, 
brownish 
red 

gray, blackish, 
faintly reddish 

≥ 5.5 none dull may be faintly sparkly hematite (rust) 
Fe2O3 

strongly 
creamy 
white 

white, may have 
brownish tint 

< 5.5 none dull greasy feel; powdery kaolinite (a clay 
mineral) 
Al2Si2O5(OH)4 

yellowish 
brown 

yellowish brown, 
orange-brown, 
dark brown 

< 5.5 none dull often occurs as a yellowish- or 
orange-ish brown, black, or 
rust-like coating or mass 

limonite 
FeO(OH)•nH2O 

green bright green < 5.5 none adamantine to vitreous; 
silky if fibrous; dull if 
massive 

commonly occurs as masses of 
tiny crystals, often with azurite 

malachite 
Cu2CO3(OH)2 

yellow, 
brown 

light yellow, 
yellowish brown, 
silvery, black 

< 5.5 6 (almost 
never 
visible) 

resinous or vitreous; 
can appear metallic 

may smell faintly like rotten 
eggs 

sphalerite 
ZnS 

yellow pale yellow < 5.5 none resinous  may smell faintly like rotten 
eggs 

sulfur 
S 
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CLEAVAGE TABLE 1 
 
Cleavage Specimen Color Luster Other Mineral Name & Formula 
none light–medium green, 

brown, yellow 
vitreous six-sided crystals apatite 

Ca5(PO4)3(F, Cl,OH) 
3 (indistinct, ≈ 
75° and 105°) 

buff, gray, white, 
pinkish 

vitreous–pearly — dolomite 
CaMg(CO3)2 

3 (only 1 
usually visible; 
others 
indistinct) 

white vitreous, silky, pearly, 
waxy 

opaque, white–gray, massive = 
alabaster; fibrous, silky–satiny luster = 
satin spar gypsum 

gypsum 
CaSO4•2H2O 

none white, may have 
brownish tint 

dull greasy feel; powdery kaolinite (a clay mineral) 
Al2Si2O5(OH)4 

none multiple greens, gray, 
black 

dull–greasy slightly greasy feel serpentine 
Mg3Si2O5(OH)4 

1 (difficult to 
see) 

white, gray, apple 
green 

pearly–greasy greasy feel, softest mineral known talc 
Mg3Si4O10(OH)2 
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CLEAVAGE TABLE 2 
 

Cleavage Specimen Color Luster Other Mineral Name & Formula 
1 (thin 
sheets) 

dark brownish black 
but not silvery, mirror-
like when thick 

vitreous; vaguely 
pearly–silky, 
metallic (when 
thick) 

cleaves into thin, flexible, elastic sheets 
that are transparent/translucent, but still 
faintly brown 

biotite (a mica) 
K(Mg,Fe)3AlSi3O10(F,OH)2 

1 (thin 
sheets) 

clear, silvery-white, 
mirror-like when thick 

vitreous; vaguely 
pearly–silky, 
metallic (when 
thick) 

cleaves into thin, flexible, elastic sheets 
that are transparent/translucent and clear 

muscovite (a mica) 
KAl2(AlSi3O10)(F,OH)2 

1 dark green vitreous–pearly cleaves into flexible but non-elastic sheets; 
does not readily split like micas 

chlorite 
complex silicate 

3 (seems like 
1; others 
indistinct) 

white, clear (as 
selenite) 

vitreous, silky, 
pearly, waxy; dull 
as alabaster 

opaque, white–gray, massive = alabaster; 
fibrous, silky–satiny luster = satin spar 
gypsum; clear = selenite 

gypsum 
CaSO4•2H2O 

2 (at nearly 
90°) 

dark green vitreous–dull crystals tend to look blocky but can 
appear splintery; greenish-gray streak 

augite 
complex silicate 

2 (at 124° 
and 56°) 

black, brownish black vitreous–dull cleavage faces stepped; appears splintery; 
pale greenish gray–no streak 

hornblende (an amphibole) 
complex silicate 

3 (at 90°) clear, white-ish vitreous–pearly tabular or rose-like crystals or massive barite 
BaSO4 

3 (at ≈ 75° 
and ≈ 105°) 

clear, white vitreous birefringent (= text/images seen through 
crystal doubled), dissolves in hydrochloric 
acid 

calcite (calcium carbonate) 
CaCO3 

3 (indistinct, 
at ≈ 75° and 
≈ 105°) 

buff, gray, white, 
pinkish 

vitreous–pearly dissolves in hydrochloric acid only when 
powdered 

dolomite 
CaMg(CO3)2 

3 (at 90°) clear, gray, reddish vitreous tastes salty (do not taste the sample 
provided!) 

halite 
NaCl (table salt) 

3 (at ≈ 46° 
and ≈ 107°) 

yellowish brown, black, 
brown, yellowish- or 
greenish-gray 

vitreous often forms blocky or tabular crystals; 
often looks like brown calcite 

siderite 
FeCO3 

3 (at 90°) clear, white, orange-ish 
or pinkish red 

vitreous very bitter taste (do not taste the sample 
provided!) 

sylvite 
KCl (salt substitute) 

4 (at 45° to 
crystal faces) 

purple, green, blue, 
yellow, clear 

vitreous often occurs as octahedral crystals fluorite 
CaF2 
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CLEAVAGE TABLE 3 
 

Cleavage Specimen Color Luster Other Mineral Name & 
Formula 

3 (rarely 
visible) 

clear, white, yellowish, 
reddish, pink, gray, black 

vitreous often forms long, four-sided crystals andalusite 
Al2SiO5 

none brown, pink, blue, gray adamantine–
vitreous 

red = ruby; blue = sapphire; second hardest 
mineral 

corundum 
Al2O3 

2 (only in 
long crystals) 

pistachio green vitreous–resinous — epidote 
complex silicate 

none reddish brown, yellowish 
tan 

vitreous–resinous 12-sided crystals common garnet 
complex silicate 

none olive green–yellowish 
green 

vitreous–dull commonly occurs as small masses of tiny 
grains 

olivine 
(Mg,Fe)2SiO4 

none clear, milky white, pale 
other colors; may 
“sparkle” with many pale 
colors 

vitreous–
resinous, 
sometimes pearly 

not technically a mineral, but a mineraloid 
because it lacks a consistent molecular 
structure 

opal 
SiO2•nH2O 

none clear, milky white, purple, 
smoky, yellow, pink 

most commonly 
vitreous; resinous 
(as rose quartz); 
dull (as jasper); 
silky (as tiger 
eye); waxy (as 
chalcedony) 

clear = crystal quartz; purple = amethyst; 
yellow = citrine; pink = rose quartz; smoky = 
smoky quartz; waxy luster = chalcedony; 
silky luster and orange-brown color = tiger 
eye; gray with dull luster = flint; red with 
dull luster = jasper; hardest common 
mineral 

quartz 
SiO2 

none reddish brown–brownish 
black 

vitreous–
resinous, dull 

often prismatic and X-shaped crystals staurolite 
Fe2Al9O6(SiO4)4(O,OH)2 

none black, pink, blue, green, 
brown 

vitreous heavy; slender crystals with triangular cross 
sections 

tourmaline 
complex silicate 
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CLEAVAGE TABLE 4 
 

Cleavage Specimen Color Luster Other Mineral Name & Formula 
1 bluish green, yellow, 

white, pink 
vitreous–resinous green = emerald; blue = aquamarine; 

commonly long, six-sided crystals with 
flat ends 

beryl 
Be3Al2(Si6O18) 

1 light blue–greenish blue vitreous blade-like crystals kyanite 
Al2SiO5 

1 white, pale green, brown vitreous–silky long, slender crystals usually in groups 
with parallel alignment 

sillimanite 
Al2SiO5 

1 clear, yellow, brown, 
pink, bluish 

vitreous long crystal prisms with pointed ends topaz 
Al2SiO4(OH,F)2 

2 (at nearly 
90°) 

black, dark green vitreous–dull crystals tend to look blocky augite 
complex silicate 

2 (only in 
long crystals) 

light, “pistachio” green vitreous–resinous — epidote 
complex silicate 

2 (at 124° 
and 56°) 

black, brownish black vitreous cleavage faces stepped; appears 
splintery 

hornblende 
(complex silicate 

2 (at nearly 
90°) 

white, dark gray vitreous crystal faces may have parallel striations plagioclase (a kind of feldspar) 
NaAlSi3O8 to CaAl2Si2O8 

2 (at nearly 
90°) 

usually characteristically 
salmon red/pink, can be 
white, gray, greenish 

vitreous (though 
often seems dull 
or resinous) 

crystal faces lack striations of 
plagioclase 

potassium feldspar 
KAlSi3O8 

3 (rarely 
visible) 

clear, white, yellowish, 
reddish, pink, gray, black 

vitreous often forms long, four-sided crystals andalusite 
Al2SiO5 
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SPECIMEN 
1 

 

COLOR  

  

LUSTER 

 

silky        metallic       vitreous (glassy)        pearly       greasy       

waxy        resinous (plastic-like)       dull (earthy) 

 

 

HARDNESS 
 

< 5.5            = 5.5          > 5.5 

 NUMBER OF 
CLEAVAGE 

PLANES 

 

0          1          2          3          4          6 

 
STREAK 
COLOR 

 

 

 MINERAL 
NAME 

 

 
MINERAL 
CLASSIFI-
CATION 

 

silicate        oxide       hydroxide       carbonate       phosphate        

sulfate       sulfide        halide       native element 

SPECIMEN 
2 

 

COLOR  

 

 

LUSTER 

 

silky        metallic       vitreous (glassy)        pearly       greasy       

waxy        resinous (plastic-like)       dull (earthy) 

 

 

HARDNESS 
 

< 5.5            = 5.5          > 5.5 

 
NUMBER OF 
CLEAVAGE 

PLANES 

 

0          1          2          3          4          6 

 STREAK 
COLOR 

 

 MINERAL 
NAME 

 

 
MINERAL 
CLASSIFI-
CATION 

 

silicate        oxide       hydroxide       carbonate       phosphate        

sulfate       sulfide        halide       native element 

 
 
 
 
 
 

(question continues on the next page) 

The hardness of 
the glass plate 

provided for you 
= 5.5. 

Test on both the 
white and black 

streak plates 
provided! 

Name:___________________________________________  Lab Section:________________________ 
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SPECIMEN 
3 

 

COLOR  

 

 

LUSTER 

 

silky        metallic       vitreous (glassy)        pearly       greasy       

waxy        resinous (plastic-like)       dull (earthy) 

 

 

HARDNESS 
 

< 5.5            = 5.5          > 5.5 

 
NUMBER OF 
CLEAVAGE 

PLANES 

 

0          1          2          3          4          6 

 STREAK 
COLOR 

 

 MINERAL 
NAME 

 

 
MINERAL 
CLASSIFI-
CATION 

 

silicate        oxide       hydroxide       carbonate       phosphate        

sulfate       sulfide        halide       native element 

SPECIMEN 
4 

 

COLOR  

 

 

LUSTER 

 

silky        metallic       vitreous (glassy)        pearly       greasy       

waxy        resinous (plastic-like)       dull (earthy) 

 

 

HARDNESS 
 

< 5.5            = 5.5          > 5.5 

 
NUMBER OF 
CLEAVAGE 

PLANES 

 

0          1          2          3          4          6 

 STREAK 
COLOR 

 

 MINERAL 
NAME 

 

 
MINERAL 
CLASSIFI-
CATION 

 

silicate        oxide       hydroxide       carbonate       phosphate        

sulfate       sulfide        halide       native element 

 
 
 
 
 
 

(question continues on the next page) 
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SPECIMEN 
5 

 

COLOR  

 

 

LUSTER 

 

silky        metallic       vitreous (glassy)        pearly       greasy       

waxy        resinous (plastic-like)       dull (earthy) 

 

 

HARDNESS 
 

< 5.5            = 5.5          > 5.5 

 
NUMBER OF 
CLEAVAGE 

PLANES 

 

0          1          2          3          4          6 

 STREAK 
COLOR 

 

 MINERAL 
NAME 

 

 
MINERAL 
CLASSIFI-
CATION 

 

silicate        oxide       hydroxide       carbonate       phosphate        

sulfate       sulfide        halide       native element 

SPECIMEN 
6 

 

COLOR  

 

 

LUSTER 

 

silky        metallic       vitreous (glassy)        pearly       greasy       

waxy        resinous (plastic-like)       dull (earthy) 

 

 

HARDNESS 
 

< 5.5            = 5.5          > 5.5 

 
NUMBER OF 
CLEAVAGE 

PLANES 

 

0          1          2          3          4          6 

 STREAK 
COLOR 

 

 MINERAL 
NAME 

 

 
MINERAL 
CLASSIFI-
CATION 

 

silicate        oxide       hydroxide       carbonate       phosphate        

sulfate       sulfide        halide       native element 

 
 
 
 
 
 

(question continues on the next page) 
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SPECIMEN 
7 

 

COLOR  

 

 

LUSTER 

 

silky        metallic       vitreous (glassy)        pearly       greasy       

waxy        resinous (plastic-like)       dull (earthy) 

 

 

HARDNESS 
 

< 5.5            = 5.5          > 5.5 

 
NUMBER OF 
CLEAVAGE 

PLANES 

 

0          1          2          3          4          6 

 STREAK 
COLOR 

 

 MINERAL 
NAME 

 

 
MINERAL 
CLASSIFI-
CATION 

 

silicate        oxide       hydroxide       carbonate       phosphate        

sulfate       sulfide        halide       native element 

SPECIMEN 
8 

 

COLOR  

 

 

LUSTER 

 

silky        metallic       vitreous (glassy)        pearly       greasy       

waxy        resinous (plastic-like)       dull (earthy) 

 

 

HARDNESS 
 

< 5.5            = 5.5          > 5.5 

 
NUMBER OF 
CLEAVAGE 

PLANES 

 

0          1          2          3          4          6 

 STREAK 
COLOR 

 

 MINERAL 
NAME 

 

 
MINERAL 
CLASSIFI-
CATION 

 

silicate        oxide       hydroxide       carbonate       phosphate        

sulfate       sulfide        halide       native element 

 
 
 
(2) For each of the following four substances, state whether or not it is a mineral. In addition: 

• if it has non-mineral occurrences, state where/when it would not be considered a mineral; 
and 

• if it is never a mineral, state why it is not. (1 point each, 4 points total). 
You should not need the Internet to answer the first three of these questions—if you do, go back 
and make sure you understand the criteria a substance must meet in order to qualify as a mineral! 
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KERATIN (the stuff your fingernails and hair 
are made of) 
 
 
 
 

OBSIDIAN (volcanic glass) 

WATER ICE 
 
 

HYDROXYLAPATITE 
 

 
You may use the Internet or other resources to find answers to questions #3–4. 

IMPORTANT NOTE: Keep in mind that many web sites cannot properly do subscript numbers 
that are required for mineral formulas (for example, it could say H2O or SiO4, but the correct 
formulas are H2O and SiO4). Be sure you report your formulas correctly—don’t just copy blindly 
from the web sites, or you will lose points! 
 
(3) The following three minerals are mined as ores for particular elements—these minerals are not 
used directly, but specific elements extracted from them are. For each mineral, provide: 

• the chemical formula, 
• the mineral group to which it belongs (use the same classification as in previous questions),  
• the predominant element extracted from the mineral and at least one of the modern uses of 

that element other than any of these unacceptable answer categories:  
o jewelry/gemstone/decoration/mineral specimen 
o money/investment/valuable  
o magic/healing/“New Age” nonsense 

IMPORTANT NOTE: Be specific in your answers—for example if a use is “magnets,” say what 
the magnets are used for; if a use is “drugs,” say what the drugs treat. (3 points each, 9 points total) 
 
XENOTIME SPODUMENE 

Chemical Formula: Chemical Formula: 

Mineral Group: Mineral Group: 

Element & Use(s): Element & Use(s): 

  

  

RHODITE  

Chemical Formula:  

Mineral Group:  

Element & Use(s):  
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(4) As you have just seen in question #3, many of the elements humans use to manufacture 
artificial materials cannot be found alone in nature—they only occur in various compound minerals 
bonded to other elements. When those minerals are mined, they must be processed to extract the 
element needed. Below is a list of three of these elements and their chemical symbols, along with 
examples of common (and familiar) places where each is used. For each, provide: 

• the name (occurrence) of at least one mineral that is a source of this element, 
• the chemical formula for that mineral, and 
• the name of the single most productive country in the world where the element (regardless of 

what mineral(s) it is extracted from) is found and mined. (Keep in mind that countries rich in 
these particular resources have a huge role in controlling the price of the resource!) 

IMPORTANT NOTE: Some of these elements occur as minor parts of other minerals and thus 
do not usually appear in the chemical formulas for those minerals. (3 points each, 9 points total) 
 
SAMARIUM (Sm) GERMANIUM (Ge) 

Element Use(s): precision-guided weapons; 
stealth technology; control rods of nuclear 
reactors; radiation treatments for cancer 

Element Use(s): blue lasers used in Blu-
Ray players; logic chips in cell phones; 
solar cells in satellites 

Mineral Occurrence: Mineral Occurrence: 

Chemical Formula: Chemical Formula: 

Most Productive Country: Most Productive Country: 

  

NEODYMIUM (Nd)  

Element Use(s): phone circuits, speakers, and 
vibration units in cell phones; powerful 
magnets used in speakers, headphones, and 
computer hard drives; electric car batteries  

Mineral Occurrence:  

Chemical Formula:  

Most Productive Country:  
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(5) This question concerns mineral resources in Utah. Natural resources are generally divided into metallic and non-metallic resources. 
You may use the Internet or other sources to find the answers to both parts of this question—if you word your searches properly and 
cleverly, you will find excellent resources that will enable you to answer the questions quickly and efficiently rather than having to jump 
around a lot from site to site or try to guess whether or not a particular mineral is metallic or not! If you find yourself looking at lots of 
sites with complex or ambiguous information, you’re probably not looking at the best sites. 
 

(a) Metallic resources are generally far rarer and more valuable than their non-metallic counterparts. Fill in the table below by listing 
five minerals (not rock types, and not elements!) that meet the following criteria: 

• they are metallic, 
• they are compound minerals (have two or more elements in them), not native elements (Cu, Au, Ag, Pt, etc.), 
• they are currently mined in Utah, and 
• they are mined for commercial purposes (i.e., in large quantities for processing, not for pretty mineral specimens). 

Then give the chemical formula and classification for each of the five minerals. HINT: Your search for answers to this question 
will likely be easier if you search for the alternative term metalliferous resources instead of metallic resources. (3 points each; 15 
points total) 

 
Mineral Name Chemical Formula Classification 
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(b) Non-metallic resources include many minerals, materials that contain numerous minerals, and even many non-minerals (such as 
oil and natural gas). Fill in the table below by listing six non-metallic minerals (not rock types, and not elements!) that meet the 
following criteria: 

• they are non-metallic, 
• they are compound minerals (have two or more elements in them), not native elements (Cu, Au, Ag, Pt, etc.), 
• they are currently mined in Utah, and 
• they are mined for commercial purposes (i.e., in large quantities for processing, not for pretty mineral specimens). 

Then give the chemical formula and classification for each of the six minerals. 
 
Mineral Name Chemical Formula Classification 
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(6) (a) A rare, raspberry-red form of the gemstone mineral beryl has its type locality (the first place 
it was ever discovered) in Utah. Although it technically goes by the (boring) name “red beryl,” and 
has also been referred to as “red emerald,” this beryl has also been given its own unique name, 
more like those of most other minerals. What was the mineral name of this type of beryl, and 
where in Utah is it found? (1 point each; 2 points total) 
 
 
 
 

(b) What in this rare form of beryl gives it its red color? (1 point) 
 
 
 
 
 

(c) Cut, faceted (as opposed to raw, uncut, but still very beautiful!) specimens of this red beryl 
are extremely expensive because of their rarity. On-line, find an example of a cut, faceted, 
unmounted (= not set into a piece of jewelry) specimen of this gemstone that is ≥1.0 carat 
(ct) in weight and is from Utah. List its weight, price, and the full URL of your source here 
for full credit, but do not use etsy.com, jtv.com, or gemservice.com, all of which frequently 
sell fake, artificially enhanced, or lab-grown (i.e., not natural) “stones.” Actual, reputable 
on-line gem shops will probably be the best bets. Have your instructor approve your 
choice! (1 point) 

 
 
 
 

(d) Based on the specimen you found and its price, determine how valuable red beryl is per 
gram (1 carat = 200 mg = 0.2 g). Show your work for full credit. (3 points) 

 
 
 
 
 
 
 
 

(e) How does this price compare to the current value (per gram) of gold (you can find the 
current value of gold on-line)? In other words, gram for gram, which is worth more: this 
rare red beryl or gold? (The value of gold is usually given in price per troy ounce; 1 troy 
ounce = 31.1 g, or 1 g = 0.032 troy ounces). Show your work for full credit. (3 points) 
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NOTES FOR MINERALS 
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LAB #4 
IGNEOUS ROCKS   

Outcrop of the Miocene, rhyolitic Joe Lott Tuff, a product of volcanic eruptions of the Mt. Belknap 
Caldera, exposed along I-70 between Fort Cove and Sevier, Utah. Photo by Jerry D. Harris.  
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 The purpose of this exercise is to provide you with first-hand experience with the major 
types of igneous rocks, their characteristics, origin, and classification. During this lab, keep in mind 
that the small specimens (hand samples) of the different igneous rock types that you will see are 
merely small pieces removed from much larger bodies of rock—when thinking about the rock 
types, the characteristics of these larger rock bodies and their formations will be far more 
important than how the specimens were obtained! 
 
Key Learning Points: 
 

• Igneous rock types, features (crystal size, if applicable), textures (phaneritic, aphanitic, 
glassy, porphyritic, and pegmatitic), and mineral compositions (felsic, intermediate, mafic, 
and ultramafic), and the relationships between them. 

• Bowen’s Reaction Series: how and why it works, and its importance. 
• The relationship between crystal size and cooling time. 
• Recognizing that igneous rocks are sources for economically valuable natural resources. 

 
 
 
This exercise is worth 75 points; point values for each question are given at the end of each 
question. 
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(1) Fill in the boxes on the right side of the Bowen’s Reaction Series table below by putting the 
names of the following six igneous rock types in the appropriate places based on the chemical 
compositions and crystallization locations of each type (1 point each; 6 points total): 
 

andesite        basalt        diorite        gabbro        granite        rhyolite 
 

 
 

You will need to refer to Bowen’s Reaction Series many times throughout this lab! 
 
(2) Examine the eight specimens provided. For each one, characterize it by circling one of the 
listed terms for each category. The texture, site of formation, and chemical composition will allow 
you to pinpoint the rock types. IMPORTANT NOTE: You should make tentative identifications 
on each until you have had a chance to see all of the different specimens in order to get a better, 
comparative feel for crystal sizes and color tones. (4 points each specimen, 32 points total) 
 

SPECIMEN 
1 

 

TEXTURE 
 

phaneritic          aphanitic          glassy 

 SITE OF 
FORMATION 

 

intrusive          extrusive 

 CHEMICAL 
COMPOSITION 

 

felsic          intermediate          mafic 

 ROCK TYPE 

 

granite          andesite          rhyolite          basalt          diorite 

gabbro          obsidian/pumice 

  

Name:___________________________________________  Lab Section:________________________ 
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SPECIMEN 
2 

 

TEXTURE 
 

phaneritic          aphanitic          glassy 

 SITE OF 
FORMATION 

 

intrusive          extrusive 

 CHEMICAL 
COMPOSITION 

 

felsic          intermediate          mafic 

 ROCK TYPE 

 

granite          andesite          rhyolite          basalt          diorite 

gabbro          obsidian/pumice 

SPECIMEN 
3 

 

TEXTURE 
 

phaneritic          aphanitic          glassy 

 SITE OF 
FORMATION 

 

intrusive          extrusive 

 CHEMICAL 
COMPOSITION 

 

felsic          intermediate          mafic 

 ROCK TYPE 

 

granite          andesite          rhyolite          basalt          diorite 

gabbro          obsidian/pumice 

SPECIMEN 
4 

 

TEXTURE 
 

phaneritic          aphanitic          glassy 

 SITE OF 
FORMATION 

 

intrusive          extrusive 

 CHEMICAL 
COMPOSITION 

 

felsic          intermediate          mafic 

 ROCK TYPE 

 

granite          andesite          rhyolite          basalt          diorite 

gabbro          obsidian/pumice 

SPECIMEN 
5 

 

TEXTURE 
 

phaneritic          aphanitic          glassy 

 
 

SITE OF 
FORMATION 

 

intrusive          extrusive 

 
 

CHEMICAL 
COMPOSITION 

 

felsic          intermediate          mafic 

 ROCK TYPE 

 

granite          andesite          rhyolite          basalt          diorite 

gabbro          obsidian/pumice 
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SPECIMEN 
6 

 

TEXTURE 
 

phaneritic          aphanitic          glassy 

 SITE OF 
FORMATION 

 

intrusive          extrusive 

 CHEMICAL 
COMPOSITION 

 

felsic          intermediate          mafic 

 ROCK TYPE 

 

granite          andesite          rhyolite          basalt          diorite 

gabbro          obsidian/pumice 

SPECIMEN 
7 

 

TEXTURE 
 

phaneritic          aphanitic          glassy 

 SITE OF 
FORMATION 

 

intrusive          extrusive 

 CHEMICAL 
COMPOSITION 

 

felsic          intermediate          mafic 

 ROCK TYPE 

 

granite          andesite          rhyolite          basalt          diorite 

gabbro          obsidian/pumice 

SPECIMEN 
8 

 

TEXTURE 
 

phaneritic          aphanitic          glassy 

 SITE OF 
FORMATION 

 

intrusive          extrusive 

 CHEMICAL 
COMPOSITION 

 

felsic          intermediate          mafic 

 ROCK TYPE 

 

granite          andesite          rhyolite          basalt          diorite 

gabbro          obsidian/pumice 

 
(3) Use Bowen’s Reaction Series to answer the following three questions. 
 

 
(a) The picture at right shows a close-up of a well-

known granite found in the vicinity of Pikes 
Peak near Colorado Springs, Colorado. The 
reddish mineral in the rock is potassium 
feldspar. What, then, should each of the 
white, gray, and black minerals in the rock be? 
(3 points) 

 
 
 
 
 
 

Photo credit: 
http://www.petrifiedwoodmuseum.org/FlorissantPicsWS/Pi

kesPeakGraniteCloseUp560.jpg 
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(b) Komatiites (pronounced koh-MAT-ee-ites) are rare, ultramafic, extrusive (volcanic) igneous 
rocks—most formed a few billion years ago, and none have formed in the last 90 million 
years or so. What would you expect to be the primary mineral(s) in a komatiite? (2 points) 

 
 
 
 
 
 

(c) Pegmatites are intrusive (plutonic) igneous rocks comprised exclusively of extremely large 
(> 3 cm) crystals (see the specimen provided for an example). They form from the last 
quantities of liquid in a magma before it completely crystallizes, but grow very large because 
of the added presence of water in the magma, which enhances crystal growth. What 
minerals would you expect to find in a typical pegmatite? (3 points) 

 
 
 
 
 
 
(4) (a) Examine the pictures of two different granites below—the one on the left is porphyritic. 
Assume that both granites are shown at the same scale (same magnification). Note that they both 
have more or less the same mineralogical compositions—that is, the same minerals are present in 
both. Given that common mineral composition between the two, why are they otherwise different? 
Specifically, what was different in the histories of the two parent magma bodies from which each 
granite formed? (5 points) 
 

            

 

 

 

Photo credit: 
http://eurasian.com/finland/granite/arctic_whit

e.html 

Photo credit: 
http://thumbs.dreamstime.com/thumblarge_575/1295351425tuY6Wq.j
pg 
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(b) If the black minerals in both specimens is the mineral hornblende (which is one of a group 
of minerals called amphiboles), then, given their light color tone, what mineral are the 
whitish crystals likely to be? (HINT: Use Bowen’s Reaction series and the sizes of the 
crystals to answer this question correctly.) (3 points) 

 
 
 
 
 
 
(5) The picture at right is a 
close-up of a specimen of a 
porphyritic basalt. Notice that 
it contains small (but visible to 
the naked eye), greenish 
crystals amid the otherwise 
typically aphanitic basalt. 
These are crystals of the 
mineral olivine. Using what 
you know of Bowen’s Reaction 
Series, find the temperature at 
which olivine begins to 
crystallize compared to the 
other minerals in the basalt 
(such as pyroxene and 
amphibole, which probably 
makes up much of the rest of 
this rock)—think specifically 
what this tells you about the 
conditions(s) (temperature, 
depth, etc.) at which the source magma for this basalt must have been. Thinking about this 
temperature difference plus the fact that crystal size depends on the amount of time in which the 
crystal can grow, discuss in a few sentences how this rock formed—why does it have two vastly 
different crystal sizes with no others in between, and what must have been the history of the 
magma body that produced this rock in order to produce such a porphyry? (5 points) 
 
 
  

Photo credit: 
http://www.pitt.edu/~cejones/GeoImages/2IgneousRocks/IgneousTextures/4PorphyriticFinez

/BasaltRoughOlPheno.jpg 
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(6) Kimberlites are a rare type of extrusive (volcanic) igneous rock that are important sources of 
many minerals resources, but are especially important (and famous) as the primary source for one 
particular mineral resource. (You may use the Internet to help answer the following questions.) 
 

(a) What is this important, famous mineral? (1 point) 
 
 
 

(b) What other (common) minerals are found in kimberlites? (3 points) 
 
 
 
 

(c) Given your answer to part (b), what is the general chemical composition (use Bowen’s 
Reaction Series!) of kimberlites? (2 points) 

 
 
 
 
 

(d) In your own words, what conditions are required for the rare mineral resource to form in a 
magma and at what depth(s) do these conditions occur? (2 points) 

 
 
 
 
 
 

(e) Given your answer to part (d), why are kimberlites classified as extrusive (volcanic) igneous 
rocks? (3 points) 

 
 
 
 
 

(f) Kimberlites are known all over the world, but in only a few places do they produce useful 
amounts of the famous mineral. Where in the world is the primary (as well as the largest 
and richest) source of kimberlites that bear this famous mineral? (3 points) 

 
 
 
 
 
 
 
 

(question continues on the next page)  
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(g) A commonly held misconception is that this famous mineral resource from kimberlites 
forms from coal (which, as you will learn later, forms from the compressed remains of land 
plants). While humans could create artificial examples of this mineral from coal, coal has 
nothing to do with the natural formation of this mineral resource—even if coal were buried 
so deeply that it melted and became part of a magma, its melted remains still wouldn’t have 
anything to do with the formation of the famous mineral from kimberlites. Aside from the 
fact that coal forms at the surface, what is the evidence that this is true? (3 points) 
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NOTES FOR IGNEOUS ROCKS 
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LAB #5 
SEDIMENTARY ROCKS   

Cliffs of Lower Jurassic Wingate Sandstone Formation capping mudstones and shales of the Upper Triassic Petrified Forest 
member of the Chinle Formation in the Wolverine Petrified Forest, Grand Staircase-Escalante National Monument, Utah. 
Photo by Jerry D. Harris. 
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 The purpose of this exercise is to provide you with first-hand experience with the major 
types of sedimentary rocks and their characteristics, origins, and classification. During this lab, 
keep in mind that the small specimens (hand samples) of the different sedimentary rock types that 
you will see are merely small pieces removed from much larger bodies of rock—when thinking 
about the rock types, the characteristics of these larger rock bodies and their formations will be far 
more important than how the specimens were obtained! 
 
Key Learning Points: 
 

• Sedimentary rock types, features (clast size grades, where applicable), classification 
(detrital/clastic, chemical, organic), and the different compositions and formations of each. 

• Sedimentary clast behavior under different conditions 
• Recognizing that sedimentary rocks are sources for economically valuable natural 

resources. 
 
 
 
This exercise is worth 85 points; point values for each question are given at the end of each 
question. 
  



 73 

For the following exercises and questions, examine the specimens available at the stations around 
the room. You may need to refer to your textbook and/or lecture notes to answer them. 
 
(1) Examine these sedimentary rock specimens and, for each one, characterize it by circling one of 
the listed terms for each category. More than one specimen of any particular rock type may be 
among the samples, and some types may not be present at all. (3 points each, 24 points total) 
 

SPECIMEN 1 CLAST SIZE 
NAME & GRADE 

gravel          sand          mud          not applicable 

 ROCK TYPE 

 

breccia          limestone          mudstone          evaporite 

conglomerate          sandstone          shale           coal 

 ROCK 
CATEGORY 

 

detrital/clastic          chemical          organic 

SPECIMEN 2 CLAST SIZE 
NAME & GRADE 

gravel          sand          mud          not applicable 

 ROCK TYPE 

 

breccia          limestone          mudstone          evaporite 

conglomerate          sandstone          shale           coal 

 ROCK 
CATEGORY 

 

detrital/clastic          chemical          organic 

SPECIMEN 3 CLAST SIZE 
NAME & GRADE 

gravel          sand          mud          not applicable 

 ROCK TYPE 

 

breccia          limestone          mudstone          evaporite 

conglomerate          sandstone          shale           coal 

 ROCK 
CATEGORY 

 

detrital/clastic          chemical          organic 

SPECIMEN 4 
CLAST SIZE 

NAME & GRADE 
gravel          sand          mud          not applicable 

 ROCK TYPE 

 

breccia          limestone          mudstone          evaporite 

conglomerate          sandstone          shale           coal 

 ROCK 
CATEGORY 

 

detrital/clastic          chemical          organic 

SPECIMEN 5 CLAST SIZE 
NAME & GRADE 

gravel          sand          mud          not applicable 

 ROCK TYPE 

 

breccia          limestone          mudstone          evaporite 

conglomerate          sandstone          shale           coal 

 ROCK 
CATEGORY 

 

detrital/clastic          chemical          organic 

 
 

(question continues on the next page)  

Name:___________________________________________  Lab Section:________________________ 
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SPECIMEN 6 CLAST SIZE 
CATEGORY 

gravel          sand          mud          not applicable 

 ROCK TYPE 

 

breccia          limestone          mudstone          evaporite 

conglomerate          sandstone          shale           coal 

 ROCK 
CATEGORY 

 

detrital/clastic          chemical          organic 

SPECIMEN 7 CLAST SIZE 
CATEGORY 

gravel          sand          mud          not applicable 

 ROCK TYPE 

 

breccia          limestone          mudstone          evaporite 

conglomerate          sandstone          shale           coal 

 ROCK 
CATEGORY 

 

detrital/clastic          chemical          organic 

SPECIMEN 8 CLAST SIZE 
CATEGORY 

gravel          sand          mud          not applicable 

 ROCK TYPE 

 

breccia          limestone          mudstone          evaporite 

conglomerate          sandstone          shale           coal 

 ROCK 
CATEGORY 

 

detrital/clastic          chemical          organic 

 
(2) You have just been handed two sedimentary rock specimens that appear identical—same color, 
same texture, etc. One is a detrital (clastic) sedimentary rock, and the other is a chemical 
sedimentary rock. You cannot see individual clasts, crystals, or any other components of either 
specimen with the naked eye. Specify two ways (tests you could perform, features you would look 
for, etc.) that you could do/use to tell the difference between them. These do not have to be 
perfect features or tests (that is, they don’t have to definitively tell you which is which), but they 
should point you strongly in one or another direction. Remember: there are different kinds of 
chemical sedimentary rocks (e.g., limestone forms differently from rock gypsum), so some tests 
may work well on one kind but not another—it’s still OK to list them here, though, but you must 
mention which kinds of rocks the tests work on! (3 points each, 6 points total) 
 

 
One way to tell the difference:  

 

 

Another way to tell the difference: 
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(3) You have just been handed two sedimentary rock specimens that appear identical—same color, 
same mineral composition, same texture, etc. One of them is an igneous rock and the other is a 
detrital (clastic) sedimentary rock. You cannot see individual clasts, crystals, or any other 
components of either specimen with the naked eye. You aren’t told anything about where they 
came from. What feature(s) might you look for to tell them apart? Recall that the grains (clasts) of 
sedimentary rocks are made of weathered and eroded crystals and that crystals in igneous rocks 
can have irregular shapes! (HINT: a microscope might help you see one specific set of features…or 
absence of those features!) NOTE: If ALL you do is state how each rock type forms, you will get 
this question wrong! (5 points) 
 
 
 
 
 
 
 
 
(4) At this station are two tubes filled with water and sedimentary clasts 
of different sizes and grades (ignore the colors, compositions, shapes, 
etc. of the clasts—they are unimportant for the purposes of this 
question). You will vigorously shake one of the tubes; the other has 
been sitting undisturbed for a long time—DO NOT touch, bump, or 
otherwise disturb this tube! Shake the appropriate tube vigorously for 
several seconds, and then set one of its ends on the table so it stands up 
vertically. Observe what happens to the different clast sizes in the tube 
immediately upon setting it down and for several seconds afterward. 
Compare what you saw (and continue to see) in this tube with the tube 
that has been sitting, undisturbed since being shaken several hours 
earlier—this tube represents what would happen to the shaken tube if it 
sat for a long time. Once you have examined and compared both tubes, 
answer the following questions. 
 

(a) In the schematic diagrams of the tubes at right, sketch and label 
the positions of the various clast sizes as they appear in each 
tube. Describe how (in what order) and when each different 
clast size (gravel, sand, mud) settled out, beginning with the 
moment you set the shaken tube on the table. If there are clasts 
that have not settled, show where they are, too. (4 points) 

 
 
 
 
 
 
 
 

(question continues on the next page)  

Shaken 
Tube 

Sitting 
Tube 
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(b) Why do the clasts settle out in this order? If there are clasts that have not settled in the 
shaken tube, why have they not settled? Will they ever settle? (3 points) 

 
 
 
 
 
 
 
 
 

(c) The picture below is of a portion of a detrital (clastic) sedimentary rock layer. Note how the 
clasts in it are arranged—this is called graded bedding. Based on the conditions necessary to 

mobilize all the clasts in the tube you shook, and 
on the results you observed in both tubes, what 
must the conditions have been that were 
responsible for (1) transporting all these clasts 
together, and then (2) depositing them in a graded 
bed that ultimately lithified into this rock, and 
where (and when) might those conditions exist in 
the real world? (3 points) 

 
 

 
 
 
 
 
 
 
 
 
 
  

Photo credit: 
http://iapetancaptain.files.wordpress.com/2010/04/graded-bedding.jpg 
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(5) At this station are four samples of a few detrital (clastic) sedimentary rocks, as well as some 
loose sediment samples (which were taken from single sources—they were not compiled from 
multiple sources). Use the loupes at this station to examine both the rocks and sediment samples, 
paying particular attention to the shapes and relative sizes of the clasts comprising each sample. 
 

(a) Rank the samples in order from angular to rounded by placing the letter of the appropriate 
specimen in its relative position (to the other samples) beneath the arrow below. (4 points) 

 
 
 
 

(b) Rank the samples in order from poorly sorted to well sorted by placing the letter of the 
appropriate specimen in its relative position (to the other samples) beneath the arrow 
below. (4 points) 

 
 
 
 

(c) In general, explain how rounding occurs, and explain how sorting occurs. (3 points) 
 
 
 
 
 
 
 
 
 
 

(d) Based on what you observed in the specimens at this station, is there a relationship 
between sorting and rounding? If so, what is the nature of this relationship and why are the 
two phenomena related? (3 points) 
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(6) At this station are three “fossilized” examples of various kinds of sedimentary structures. For 
each, do the following: name the type of structure (not the rock type!), sketch the structures on the 
specimen, and state what must have been the environment in which the structures originally 
formed (in the loose sediment that eventually lithified into the rock you see). Specify environment 
types (e.g., “deep ocean”); don’t just use vague descriptive terms (e.g., “cold”), and specify what 
qualities about those environments create the conditions suitable to form each particular kind of 
sedimentary structure. (3 points each; 9 points total) 
 

 
STRUCTURE 

NAME SKETCH OF SPECIMEN 
ENVIRONMENT 
OF FORMATION 

SP
E

C
IM

E
N

 A
 

  
 
 
 
 
 
 
 
 
 
 
 

 

SP
E

C
IM

E
N

 B
 

  
 
 
 
 
 
 
 
 
 
 
 

 

SP
E

C
IM

E
N

 C
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(7) Many of the non-metallic mineral resources mined in Utah come from detrital (clastic) and chemical sedimentary rocks. List five of 
these sedimentary rock resources and, for each one, the kind of sedimentary rock from which it is extracted, one of the (general) parts of 
Utah in which it is mined, and at least one modern use for that particular kind of resource (regardless of where it is mined). (4 points 
each; 20 points total) 
 

RESOURCE (IF 
APPLICABLE) 

ROCK TYPE RESOURCE IS 
EXTRACTED FROM 

MINED IN WHAT 
(GENERAL) PART OF 
UTAH USE 
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NOTES FOR SEDIMENTARY ROCKS 
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LAB #6 
METAMORPHIC ROCKS  
 
 
 
 
 
 
 
 
 
  

1.7 billion-year-old gneisses and schists cross-cut by pegmatite dikes, Black Canyon of the Gunnison National Park, Colorado. 
Photo by Jerry D. Harris 
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 The purpose of this exercise is to provide you with first-hand experience with the major 
types of metamorphic rocks and their characteristics, origins, and classification. During this lab, 
keep in mind that the small specimens (hand samples) of the different metamorphic rock types 
that you will see are merely small pieces removed from much larger bodies of rock—when thinking 
about the rock types, the characteristics of these larger rock bodies and their formations will be far 
more important than how the specimens were obtained! 
 
Key Learning Points: 
 

• Metamorphic rock types, features (types of foliation, if present), classification (foliated and 
non-foliated), and the different heats and pressures that govern the formation of each. 

• Recognizing that metamorphic rocks are sources for economically valuable natural 
resources. 

 
 
 
This exercise is worth 70 points; point values for each question are given at the end of each 
question. 
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For the following exercises and questions, examine the specimens available at the stations around 
the room. You may need to refer to your textbook and/or lecture notes to answer them. 
 
(1) Characterize each of the specimens by circling one of the listed terms for each category. (5 
points each specimen, 40 points total) 
 

SPECIMEN 1 TEXTURE 
nonfoliated         foliated: slaty cleavage        foliated: schistose  

foliated: phyllitic          foliated: gneissic         foliated: other 

 AMOUNT OF 
HEAT low          moderate          high 

 AMOUNT OF 
PRESSURE low          moderate          high 

 ROCK TYPE 

slate          gneiss         marble          schist         phyllite 

quartzite: metasandstone   —or—  metaconglomerate/breccia 

anthracite 

 PARENT 
ROCK 

granite          sandstone          coal          shale          basalt          

conglomerate/breccia          limestone          no way to tell 

SPECIMEN 2 TEXTURE 
nonfoliated         foliated: slaty cleavage        foliated: schistose  

foliated: phyllitic          foliated: gneissic         foliated: other 

 AMOUNT OF 
HEAT low          moderate          high 

 
AMOUNT OF 

PRESSURE low          moderate          high 

 ROCK TYPE 

slate          gneiss         marble          schist         phyllite 

quartzite: metasandstone   —or—  metaconglomerate/breccia 

anthracite 

 PARENT 
ROCK 

granite          sandstone          coal          shale          basalt          

conglomerate/breccia          limestone          no way to tell 

(question continues on the next page) 

Name:___________________________________________  Lab Section:________________________ 
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SPECIMEN 3 TEXTURE 

nonfoliated         foliated: slaty cleavage        foliated: schistose  

foliated: phyllitic          foliated: gneissic         foliated: other 

 AMOUNT OF 
HEAT 

low          moderate          high 

 AMOUNT OF 
PRESSURE 

low          moderate          high 

 ROCK TYPE 

slate          gneiss         marble          schist         phyllite 

quartzite: metasandstone   —or—  metaconglomerate/breccia 

anthracite 

 PARENT 
ROCK 

granite          sandstone          coal          shale          basalt          

conglomerate/breccia          limestone          no way to tell 

SPECIMEN 4 TEXTURE 
nonfoliated         foliated: slaty cleavage        foliated: schistose  

foliated: phyllitic          foliated: gneissic         foliated: other 

 AMOUNT 
OF HEAT low          moderate          high 

 
AMOUNT 

OF 
PRESSURE 

low          moderate          high 

 ROCK TYPE 

slate          gneiss         marble          schist         phyllite 

quartzite: metasandstone   —or—  metaconglomerate/breccia 

anthracite 

 PARENT 
ROCK 

granite          sandstone          coal          shale          basalt          

conglomerate/breccia          limestone          no way to tell 

 
 
 
 
 

(question continues on the next page)  
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SPECIMEN 5 TEXTURE 
nonfoliated          foliated: slaty cleavage         foliated: schistose  

foliated: phyllitic          foliated: gneissic         foliated: other 

 AMOUNT 
OF HEAT 

low          moderate          high 

 AMOUNT 
OF 

PRESSURE 

low          moderate          high 

 ROCK TYPE 

slate          gneiss         marble          schist         phyllite 

quartzite: metasandstone   —or—  metaconglomerate/breccia 

anthracite 

 PARENT 
ROCK 

granite          sandstone          coal          shale          basalt          

conglomerate/breccia          limestone          no way to tell 

SPECIMEN 6 TEXTURE 
nonfoliated          foliated: slaty cleavage         foliated: schistose  

foliated: phyllitic          foliated: gneissic         foliated: other 

 AMOUNT 
OF HEAT low          moderate          high 

 AMOUNT 
OF 

PRESSURE 
low          moderate          high 

 ROCK TYPE 

slate          gneiss         marble          schist         phyllite 

quartzite: metasandstone   —or—  metaconglomerate/breccia 

anthracite 

 PARENT 
ROCK 

granite          sandstone          coal          shale          basalt          

conglomerate/breccia          limestone          no way to tell 

 
 
 
 

(question continues on the next page)  
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SPECIMEN 7 TEXTURE 
nonfoliated          foliated: slaty cleavage         foliated: schistose  

foliated: phyllitic          foliated: gneissic         foliated: other 

 AMOUNT 
OF HEAT 

low          moderate          high 

 AMOUNT 
OF 

PRESSURE 

low          moderate          high 

 ROCK TYPE 

slate          gneiss         marble          schist         phyllite 

quartzite: metasandstone   —or—  metaconglomerate/breccia 

anthracite 

 PARENT 
ROCK 

granite          sandstone          coal          shale          basalt          

conglomerate/breccia          limestone          no way to tell 

SPECIMEN 8 TEXTURE 
nonfoliated          foliated: slaty cleavage         foliated: schistose  

foliated: phyllitic          foliated: gneissic         foliated: other 

 AMOUNT 
OF HEAT low          moderate          high 

 AMOUNT 
OF 

PRESSURE 
low          moderate          high 

 ROCK TYPE 

slate          gneiss         marble          schist         phyllite 

quartzite: metasandstone   —or—  metaconglomerate/breccia 

anthracite 

 PARENT 
ROCK 

granite          sandstone          coal          shale          basalt          

conglomerate/breccia          limestone          no way to tell 
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(2) Metamorphism is caused by the applications of heat and pressure to existing rocks. However, 
the amounts of heat and pressure vary from one regime (= one place and set of conditions) to 
another; where one increases, the other does not necessarily follow. Foliated metamorphic rocks 
have foliations because they have had differential stress (pressure) applied to them during the 
metamorphic process—the stress does two things: (a) it flattens existing crystals/grains in the parent 
rock (in addition to high temperatures enabling ion migration along crystals), and (b) it reorients 
them perpendicular to the direction of the differential stress. Nonfoliated metamorphic rocks, in 
contrast, can form in two different kinds of pressure regimes—what are they? (2 points each; 4 
points total) 
 
 
 
 
 
 
 
 
 
 
 
(3) The most common uses for most metamorphic rock types are decorative, in art (e.g., 
sculptures, headstones) and construction (e.g., building stones, tiles). However, anthracite is not 
used in either of these two ways…but it still has an important use. (You may use your lecture 
textbook, other books, or the Internet to help find the answers to these questions.) 
 

(a) What is the parent rock of anthracite? (1 point) 
 
 
 

(b) What are both anthracite and its parent rock used for, and, despite the fact that it’s much 
more expensive, why is anthracite preferable for this use over its parent rock? (4 points) 

 
 
 
 
 
 

(c) Where in the U.S. is most anthracite mined? (2 points) 
 
 
 
 

(d) Utah is rich in the parent rock of anthracite. But is anthracite itself mined anywhere in 
Utah? (2 points) 
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(4) Serpentinite is a special type of metamorphic rock that commonly forms via hydrothermal 
metamorphism of mafic igneous rocks, such as basalt. Many serpentinites are rich in greenish 
minerals*. Some kinds of serpentinite resemble some kinds of marble and are particularly prized 
as decorative stones. One of the common components of serpentinite is the mineral chrysotile, 
which is a member of a group of infamous minerals that is known by another (common) name. 
(You may use various books or the Internet to help find the answers to the following questions.) 
 

(a) What is this other name? (1 point) 
 
 
 
 

(b) Minerals in this group used to be used heavily in the manufacture of brake pads in vehicles 
and in various building materials, particularly many kinds of insulation and flame 
retardants, because they are quite heat resistant. Building renovations that require removing 
these materials are dangerous and require special precautions and procedures—what can 
happen to them if removed improperly? (4 points) 

 
 
 
 
 
 
 
 

(c) The use of these minerals in manufacturing has been banned in the U.S. and many other 
countries because they have been linked to several, usually fatal, medical conditions. What 
are some of these conditions, and what primary part of the body do they affect? (4 points) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
*The name “serpentinite” derives from the same Latin root as “serpent,” meaning snake, possibly because of the 
similarity of the color to some snakes, or of the waxy luster of some of the minerals in serpentinite to snake scales
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(5) You, a geologist, have been contracted by a conscientious developer that is considering 
developing two hillside properties (A and B, below) for a housing development. Your analysis of 
both localities reveals that the bedrock underlying the hillsides is foliated metamorphic rock, 
particularly phyllite and schist. You have been able to determine the directions of the foliations of 
the rocks comprising each hill (see pictures below). Based on this information, combined with 
what you know about the natures of the textures and structures of phyllite and schist, which of the 
two hillsides would you tell the developer is better for a housing development and why is your 
choice better? (8 points) 
 
 
 
 
 
  



 91 

  



 92 

NOTES FOR METAMORPHIC ROCKS 
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LAB #7 
GEOLOGIC TIME: 
STRATIGRAPHIC (RELATIVE) 
AND RADIOMETRIC DATING   

Pliocene, mafic dike cutting through Permian, marine strata of the Darwin Canyon Formation, near Darwin Falls, Death Valley 
National Park, California. Photo by Garry Hayes (from http://geotripperimages.com/Volcanism/Plutons%20and%20intrusions.htm) 

http://geotripperimages.com/Volcanism/Plutons%20and%20intrusions.htm
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 This lab has two parts: 
 
STRATIGRAPHIC DATING 
 The purpose of this portion of the exercise is to provide you with some experience with the 
stratigraphic dating methods that geologists employ to figure out the relative ages of various rock 
layers (strata)  and other bodies. You will be doing this with diagrams, but in reality, many 
geologists spend large amounts of time in the field mapping where various rock bodies are and 
their relationships to each other, gathering the necessary information to reconstruct such diagrams. 
For biostratigraphic dating, geologists can consult published reports of fossil occurrences around 
the world in order to tie the rocks they are studying to those in far-away places. The use of 
stratigraphic dating principles over the last two centuries not only enabled the construction of the 
geologic time scale, but also provided the foundations for our modern understanding of 
evolutionary processes, which are the foundation of all modern biology (including medicine), and 
the only body of data about the evolutionary history of all life on Earth. No one place in the world 
preserves rocks and/or fossils from all time periods in sequence, but vast numbers of places 
preserve rocks and fossils from different segments of time; deducing their relative positions to one 
another is therefore critical not only to geology, but to biology, as well. 
 
RADIOMETRIC DATING 
 The purpose of this part of the exercise is to provide you with first-hand experience with 
the principles of radiometric dating. Of course, we will not be using any actual radioactive material 
in class; instead, in the first part of this lab, you will use dice in a simulation. The dice serve as a 
good model for actual, radiometrically decaying atoms because, in important ways, they behave the 
same way that unstable atoms do. The dice therefore will be our proxies for actual atoms. In the 
second part of the lab, you will be answering a few questions about actual radiometrically decaying 
isotopes. 
 
Key Learning Points: 
 

• Application of stratigraphic dating principles, including the principles of fossil succession, 
original horizontality, superposition, lateral continuity, cross-cutting relationships, and 
inclusions, as well as different kinds of unconformities and their recognition and meanings. 

• Biostratigraphic correlation and its application to the dating of strata. 
• Half lives (t½), decay constants (λ), and the relationship between them using the formulas: 

t½ = 0.693/λ               and               λ = 0.693/t½ 
• Creating a graph from collected data. 
• Determining a half life from an exponential decay curve by reading a graph. 
• Real-world applications of simple algebra. 

 
 
This exercise is worth 85 points; point values for each question are given at the end of each 
question. 
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Stratigraphic Dating 

 Below (questions #1–2) are schematic geologic cross sections—think of these as gigantic (tens, even hundreds, of kilometers 
across) slices through the ground in different locations that expose the internal geology of the ground. Each one exposes a number of 
geologic features, each representing an event: emplacement (e.g., of a magma body, a fault), deposition (e.g., of sediment), creation of a 
structure (e.g., tilting or folding of strata), erosion, etc. All the sections use the same set of symbols for rock types; a legend for these 
symbols is given below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In all cross sections, straight (linear) contacts between rock units are conformable, and irregular (wavy) contacts are unconformable 
(erosional). 
 

You should do the exercises in this lab in pencil in case you have to erase and revise as you go. 
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(1) (a) Place the labeled events/features in chronologic order from first/oldest to last/youngest by placing the letter of the event/feature in 
the appropriate blank accompanying the cross section. Then answer the questions below the cross section. (10 points) 
 
 
 

 
 
FIRST 11 

 
 
2 12 

 
 
3 13 

 
 
4 14 

 
 
5 15 

 
 
6 16 

 
 
7 17 

 
 
8 18 

 
 
9 19 

 
 
10 LAST 

 
 
 
 

(b) What kind of unconformity is J? (1 point) 
 

(c) What kind of unconformable contact does Q have with all the strata that it touches? (1 points) 
  

Name:___________________________________________  Lab Section:________________________ 
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(2) 

 
 
The cross section above is similar to the ones you saw in question #1, but here nothing has been labeled—you must identify all the 
events/features yourself. Do the following: 

• Label each feature/event in chronological order (starting with the oldest as #1) on the cross section itself (you can use arrows to 
link your labels to features if they are too dark to write directly on). Make sure your labels are legible, visible, and unambiguous!  

• Treat the alternating sandstone–coal sequence as a single unit (just to make things easier). 
• For any unconformities, specify (if possible) what kind each is. 
• If the relative ages of any two (or more) events/features cannot be determined, explain why not, and specify what additional data 

would you need to make such a determination. 
• Don’t forget geologic-structure-creating events and erosional features! (20 points) 
 

If you need to, put (or continue) your answers on the next page.
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(3) The diagram on the following page depicts fossil-bearing stratigraphic sections in three widely 
separate places around the world. However, some of the strata at each are the same age. The ages 
of units that can be radiometrically dated (i.e., igneous rocks, including volcanic ashes deposited 
along with sediments that ultimately became sedimentary rocks) are given on the section. Use the 
fossil and radiometric data from these sections to answer the following questions. 
 

(a) What is the narrowest age range that can be determined for the coral? (1 point) 
 
 
 

(b) What is the narrowest age range that can be determined for the dinosaur track? (1 point) 
 
 
 

(c) What is the narrowest age range that can be determined for the crinoid? (1 point) 
 
 
 

(d) What is the narrowest age range that can be determined for arthropod B? (1 point) 
 
 
 

(e) What is the narrowest age range that can be determined for the fish? (1 point) 
 
 
 

(f) What is the narrowest age range that can be determined for echinoderm B? (1 point) 
 
 
 

(g) Is bivalve D likely closer in age to dinosaur B or to the ostracode and what enables such a 
determination? (HINT: examine the strata and their contacts closely!) (2 points) 

 
 
 
 
 

(h) Are there any fossil organisms in any of these three sections whose age can be determined 
with a great deal of precision? If so, which one and how old is it? (2 points) 

 
 
 
 
 

(question continues on the next page)  
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(i) Dinosaurs first evolved approximately 230 million years ago and (except for birds) went 
extinct at the end of the Cretaceous, approximately 65 million years ago. Do the dinosaur 
fossils found in the areas depicted in the three sections support or refute these established 
dates, and how do they do so? (2 points) 

 
 
 
 
 
 
 
 
 

(j) Approximately how much time does the unconformity marked X represent and how do 
you know? (3 points) 
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Radiometric Dating 

 For the first part of this exercise, you will work in small groups to collect and analyze data 
that involve rolling 200 six-sided dice, each with one colored side. Each die in the set represents 
one atom of an unstable isotope. The dice will serve as a greatly simplified model of how half lives 
are determined for radioactive, unstable isotopes—they are a good model because in the same way 
that it is impossible to predict when any actual atom of an unstable isotope in a sample will decay, 
it is impossible to predict before a roll which face of a die will come up after a roll…but, statistically 
speaking, some will! On the table on the next page, write down the data obtained during your dice 
rolls. 
 
Follow these steps your trial: 
 
Step 1: Roll all the dice in the container, and record the number of dice you rolled on the table 

provided. 

Step 2: Any dice that are colored-side up after the roll have “decayed”—remove these from the set 
and count them; record this number in the table provided. 

Step 3: Return all the “un-decayed” dice to the container. (When you have just a few dice left, you 
can roll them by hand rather than put them in the container before rolling.) 

Step 4: Repeat steps 1–3 until all the dice have “decayed.”  

Step 5: Plot your data on the graph provided. Note carefully where your first data point will land 
on the graph (HINT: it’s not at roll #1!). 

Step 6: DO NOT CONNECT THE DOTS  on the graph. Instead, draw in (as best as possible) a 
smooth curve that “fits” the dots for each trial as best as possible (your lab instructor will show 
you examples of such curves for actual isotopes). 

Step 7: Use your graphed data to determine the half life of the dice for the trial. Your teacher will 
demonstrate how to do this. Note that the technique for doing this works not only for dice, but 
for all decaying isotopes, as well. 

 
 
 
 
 

For all questions that require doing math in this exercise, show all your 
work to receive full credit. Answers that do not show the math will not be 

given credit, even if the answer is correct! 
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ROLL # 
(time) 

# DICE 
ROLLED 

(count) 

# DICE 
DECAYED 

 ROLL # 
(time) 

# DICE 
ROLLED 

(count) 

# DICE 
DECAYED 

1    26   

2    27   

3    28   

4    29   

5    30   

6    31   

7    32   

8    33   

9    34   

10    35   

11    36   

12    37   

13    38   

14    39   

15    40   

16    41   

17    42   

18    43   

19    44   

20    45   

21    46   

22    47   

23    48   

24    49   

25    50   
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(4) Using the piece of graph paper provided, graph the results of the dice rolled (note that if there 
were more steps in the trial than allowed by the graph, you only have to graph as much as possible 
given the space on the graph). As determined from your graph, what is the half-life (t½) of the dice 
for this trial? Get your data from the graph, and show your measurements there, but show your 
work in calculating the half life here. (12 points) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(5) Given the half-life you determined above, what is the “decay constant” (λ) of the dice? (Use the 
formula for the decay constant λ provided above). (3 points) 
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(6) As you are probably aware, dice have a finite probability (the “odds”) of getting any one 
particular face up after a roll, and this probability is a function of how many sides each die has. By 
having such easily calculated probabilities, dice are not great models for decaying atoms, despite 
the fact that the dice are otherwise good models (as detailed above). As it turns out, this probability 
is the “decay constant” (λ) of the dice—you can think of the decay constant of any unstable isotope 
as like the probability that any atom in a sample will decay. 
 

(a) Given that each of your dice has six sides, theoretically, what then should the “decay 
constant” of the dice be? (2 points) 

 
 
 
 
 

(b) Is this theoretical decay constant the same as your experimentally determined one from 
above (question #5)? (1 point) 

 
 
 
 
 
(7) Given the theoretical decay constant you got in question #6, what is the theoretical (true) half 
life (t½) of a six-sided die? Use the formula for t½ provided in the lecture and above. (2 points)  
 
 
 
 
 
 
 
 
 
(8) Let’s see how different your experimental half life is from the theoretical (true) half life—we’ll 
do this as a percentage. To do this, use this formula: 
 

% 𝑒𝑟𝑟𝑜𝑟 = �
|𝑒𝑥𝑝𝑒𝑟𝑖𝑚𝑒𝑛𝑡𝑎𝑙 𝑡½ − 𝑡𝑟𝑢𝑒 𝑡½|

𝑒𝑥𝑝𝑒𝑟𝑖𝑚𝑒𝑛𝑡𝑎𝑙 𝑡½
� × 100 

 
…where the vertical lines ( | ) mean “take the absolute value of” (that is, if the number you get for 
(experimental t½ – true t½) is a negative number, drop the negative sign and use the number as if it 
were positive). (2 points) 
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(9) So now you have two values for the half life of the dice: the experimental value (from question 
4) and the theoretical (true) value (from question #7). In all likelihood, they are not the same 
number, and may not even be very close (as you saw in question #8). Without changing the dice, 
what one thing could you do in the future to obtain a value for the experimental half-life of the dice 
that is closer to the true half life value? (3 points) 
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Use the tables below to answer questions #10–13. 
 

SELECT ISOTOPES USED IN RADIOMETRIC DATING IN GEOLOGY 
Name of Dating 
Type Parent Isotope (P) 

Daughter Isotope 
(D) Half-life (t½) Materials Dated 

samarium–
neodymium 
dating 

samarium-147 
(147Sm) 

neodymium-143 
(143Nd) 

106 billion 
yr various minerals 

rubidium–
strontium dating rubidium-87 (87Rb) strontium-87 (87Sr) 49 billion yr hornblende and 

feldspar 
rhenium–
osmium dating rhenium-187 (187Re) osmium-187 (187Os) 42 billion yr iron- and sulfur-rich 

igneous minerals 
uranium–lead 
dating uranium-238 (238U) lead-206 (206Pb) 4.5 billion yr zircon 

argon–argon 
dating argon-40 (40Ar) argon-39 (39Ar) 1.3 billion yr sanidine (a feldspar) 

uranium–lead 
dating uranium-235 (235U) lead-207 (207Pb) 704 million 

yr zircon 

carbon dating carbon-14 (14C) nitrogen-14 (14N) 5715 yr any organic 
materials 

 
 

DECAY PARAMETERS (FOR ALL ISOTOPES) 
% P % D # Half-lives Elapsed Age 
100.0 0.0 0 0 

98.9 1.1 1/64
 t½ x 0.015 

97.9 2.1 1/32 t½ x 0.031 

95.9 4.2 1/16 t½ x 0.062 

91.7 8.3 1/8 t½ x 0.125 

84.1 15.9 ¼ t½ x 0.250 
70.7 29.3 ½ t½ x 0.500 
50.0 50.0 1 t½ 
35.4 64.6 1½ t½ x 1.500 
25.0 75.0 2 t½ x 2.000 
12.5 87.5 3 t½ x 3.000 
6.2 93.8 4 t½ x 4.000 
3.1 96.9 5 t½ x 5.000 
1.6 98.4 6 t½ x 6.000 
0.8 99.2 7 t½ x 7.000 
0.4 99.6 8 t½ x 8.000 
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(10) A solidified lava flow containing zircon crystals is among strata exposed in an outcrop. Zircon 
crystals from this lava flow were dated using the 235U–207Pb method, which found a ratio of 71% 235U 
to 29% 207Pb atoms in the crystals. 
 

(a) How many half-lives have elapsed for this pair of isotopes? (1 point) 
 
 
 
 
 
 

(b) What is the age of the lava flow? Show your work for full credit. (3 points) 
 
 
 
 
 
 
 
 
 
(11) The age of the Earth has been determined by dating isotopes, particularly 238U and 206Pb, in 
meteorites. Although not from Earth, these meteorites and Earth (as well as everything else in the 
Solar System) all formed at the same time. The oldest meteorites ever found contain nearly equal 
amounts of both 238U and 206Pb. How old, then, is the Earth? (2 points) 
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(12) All organisms on Earth take in carbon atoms throughout their lives. Some of these atoms are 
of 14C. While alive, any atoms of 14C (or any other isotope of carbon) in an organism’s body are 
continually replenished. However, when an organism dies, no new 14C is taken in, and the amount 
of 14C in its body begins to decrease as it begins to decay to 14N. 
 

(a) A layer of peat (decaying plant matter that has not yet become coal) contains archeological 
artifacts of a past human habitation, and you are interested in figuring out how long ago the 
humans lived in this area. The peat has about 6% of the 14C in modern organisms. How 
old, then, is the peat bed? Show your work for full credit. (3 points) 

 
 
 
 
 
 
 
 
 
 

(b) When sampling the peat, you have to avoid including any pieces of an underlying 
limestone or of young, modern plant roots. Why? (Be specific—overly general answers will 
not receive credit!) (3 points) 

 
 
 
 
 
 
 
 
(13) Zircon (ZrSiO4) crystals form when many magmas and lavas solidify into igneous rock. Often, 
uranium atoms are incorporated into the crystal structure of the zircon crystals. Walking along a 
sandy beach somewhere, you note that some of the sand grains are weathered pieces of zircon 
crystals. If you radiometrically dated any of these grains that have uranium atoms in them, would it 
tell you the age of the beach on which you are walking? Why or why not? (3 points) 
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NOTES FOR GEOLOGIC TIME 
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LAB #8 
STREAMS &  
GROUNDWATER   

The Ural River in western Kazakhstan is surrounded by oxbow lakes and meander scars. From Google Earth. 
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 The purpose of this exercise is to give you some experience recognizing surface features 
created by streamflow and groundwater. Because (a) both of these are global phenomena, (b) they 
are uncommon in our vicinity and therefore difficult to see firsthand, and (c) seeing them well 
requires gaining a lot of altitude, you will instead use Google Earth to examine and explore several 
such features in various places around the world. 
 
Key Learning Points: 
 

• Recognizing various streamflow- and groundwater-created surface features. 
• Using Google Earth as a tool to locate and examine specific places. 

 
 
 
This exercise is worth 80 points; point values for each question are given at the end of each 
question. 
 



 118 

 For this exercise, you will be using the free, stand-alone (not web-based) program Google 
Earth to virtually “visit” various geographic locations around the planet in order to see and identify 
geological structures that were created by the surface processes of streamflow and groundwater. 
Google Earth uses a collection of satellite photos to depict the entire surface of the planet, much of 
it in 3D. You will need a computer (either PC or Mac); if Google Earth is not already installed on 
it, go to http://earth.google.com to download its installer; you will need to run that installer after it 
has downloaded. You will be doing part of the exercise in Microsoft Word, so your computer 
must have that installed as well (or another program into which you can paste pictures and label 
them). 

 In case you have never used Google Earth before, on the next page is a brief overview of its 
basic controls (the ones you will need for this exercise) and how to use them. Before doing this 
exercise, you should spend some time practicing with the different controls so that you know how 
to use them and know what they do—to answer some of the questions on this exercise, you will 
need to be able to use the controls in complex ways!  Try, for example, finding your house, or 
Dixie State College. Fly deep into Grand Canyon and look up at its walls as if you were standing 
down in the Colorado River in its bottom. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://earth.google.com/
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In addition to these controls, here are some other useful things: 

• You can zoom into any spot simply by double-clicking on it on the map (whether or not there is a label on it). Note that only in the continental 
United States is the resolution pretty high at low altitudes; elsewhere in the world will be blurry very close up. 

• The cursor, when over the map, turns into a hand; you can click and hold the hand (which turns into a fist) and drag the view in any direction. 
• If, when dragging a view, you let go while it’s moving, it will “coast” on its own; just click anywhere in the picture to stop it. 
• You need to know north, east, south, and west. Knowing what longitude and latitude are will be helpful, too. 
 

Fly—after entering text into the Search box, click this 
magnifying glass to fly to the location you entered. 

Layers—use the 
check boxes in this 
window to turn on 
various features. For 
this exercise, the only 
one you will want 
checked will be 
Borders; having any 
others on will clutter 
up your view, though 
some of the Photos 
are very cool! 

Eye Altitude—this 
tells you how high 
you are above the 
surface you are 
looking at. (If this 
isn’t showing, make 
sure “Status Bar” is 
checked in the 
“View” menu. 

Search—type (or cut 
and paste) text, such 
as coordinates 
(latitude, longitude) 
or names of places 
into this box. 

Zoom—use this 
slider bar to zoom 
in (+) or out (-). 

Move—use the 
arrows in this circle 
to move north, east, 
south, or west. 

Pan—use the arrows 
in this circle to pan 
(tilt) or pivot your 
view in different 
ways. 

Compass—you can grab the “N” and rotate it 360º to see 
things from different angles. Double click on the “N” to 
put north back to “up.” 

Coordinates—the latitude and longitude of 
the place you are looking at. 
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IN ADDITION TO THE QUESTIONS IN THIS EXERCISE… 
 
 As part of this exercise, you will be copying some pictures from Google Earth into a 
Microsoft Word document; you will then print out and turn in this document in addition to 
the pages on which you answer the questions in this lab exercise. For this Microsoft Word 
document, do the following: 
 

• Open Microsoft Word at the beginning of this exercise. 
• After pasting pictures from Google Earth into Microsoft Word, you may have to shrink 

the pictures—you will want to have two or three pictures per page (to save paper). To do 
this: 

o Click on the picture in Microsoft Word—a series of white dots (handles) will 
appear at the corners and in the middle of the edges of the picture. 

o Click and hold on any of the corner handles, and drag toward the inner part of 
the picture to make it smaller. Release the handle by lifting your finger off the 
mouse button to keep it at its appropriate size. Please keep it at a size in which 
its contents are visible! 

o Once at an appropriate size, you can move the picture around the page. 
o Create labels for your pictures below the pictures themselves. You can do this 

by entering a bunch of carriage returns (pressing “Enter” or “Return” several 
times) until the cursor is below the picture; then type your label. There are 
other ways of doing this, too, and you are welcome to use them if you know 
them. 

o Please put a few extra carriage returns between your pictures! 
• Save your document often, or else you may end up having to redo them all from 

scratch! 
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(1) (a) Enter the following coordinates2 in the search box: 40°13'13.03"N, 96°43'44.95"E, and zoom 
to an eye altitude of about 120 mi. This is a great, very large example of a particular kind of 
sedimentary structure, which is on the north flank of the Qilian Mountains in Gansu Province, 
China. From the “Edit” menu, choose “Copy Image” to copy a picture of your view; then paste the 
copied image into your Microsoft Word document and label it: “1a) Qilian.” (2 points) 
 

(b) What kind of structure is this? (1 point)  
 
 
 

(c) What must the climate (not environment!) in this part of China be like in order for this 
structure to have formed? (2 points)  

 
 
 
 

(d) What other geological structures near these coordinates (not including other examples of 
the kind of structure seen at the coordinates above—you will have to zoom out and move 
around to see the larger picture) provide evidence of this year-round climate? If so, what is 
this evidence? Note that a lack of vegetation is not a geological structure! (2 points) 

 
 
 
 
 
 
 

(e) From the “Edit” menu, choose “Copy Image” to copy a picture of your view of one such 
structure; then paste the copied image into your Microsoft Word document and label it: 
“1e) Other Evidence.” (2 points) 

 
(f) Now enter the following coordinates in the search box: 36°46'37.62"N, 114° 0'23.36"W, and 

zoom to an eye altitude of about 25,000 ft. You are looking at the small town of Scenic, 
Nevada, which is just outside of the larger city of Mesquite. Note the green riparian zone 
around the Virgin River north and west of town, and the green, tree-covered slopes of the 
Virgin Mountains to the south and east. The town of Scenic, however, sits on a vast, brown 
plain. Zoom back out to an eye altitude of about 50 mi.: now you can see that this brown 
plain extends along the entire northern slope of the Virgin Mountains. This brown plain is 
an example of several, overlapping structures of the type you identified in China above. 
What is the name of a conjoined series of these structures? (1 point) 

 
 

(question continues on the next page)  
                                                           
2To type a degree symbol on a Windows PC, hold down the “Alt” key and, on the keypad (not the numbers across the 
top of the keyboard!), type 0176. On a Mac, hold down the “Option” or “Alt” key and type 0. 

 

Name:___________________________________________  Lab Section:________________________ 
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(g) Knowing what kind of structure the town of Scenic is built on, would this be a good place 
to build a house? Why or why not? (HINT: think about why there are no trees on the 
brown plain!) (3 points) 

 
 
 
 
 
 
 
 
 
 
(2) (a) In the Search box, type in “Burkes Bridge, Australia” and fly there. Just east of this town is a 
portion of the Murray River. Zoom in on a part of the river in this region (down to an eye altitude 
of about 26,000 ft. is good). From the “Edit” menu, choose “Copy Image” to copy a picture of 
your view; then paste the copied image into your Microsoft Word document and label it: “2a) 
Murray River.” (2 points) 
 

(b) What kind of river is this and what features do you see that tells you this? (3 points)  
 
 
 
 
 
 

(c) On the picture you pasted in above, label (in Word if possible, or by hand after printing) 
the following structures (1 point each; 6 points total): 

 
• Three examples of point bars. 
• Three examples of cut banks. 
• One oxbow lake or meander scar. 
• Two places where, in the near future, the river is likely to cut off an old channel and form a 

new oxbow lake or meander scar.  
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(3) (a) Enter the following coordinates in the search box: 50°3'20.54"S, 72°6'0.31"W. Zoom in on a 
part of the river in this region (down to an eye altitude of about 32,000 ft. is good). You are looking 
at a portion of the La Leona River in Santa Cruz Province, Argentina. From the “Edit” menu, 
choose “Copy Image” to copy a picture of your view; then paste the copied image into your 
Microsoft Word document and label it: “3a) La Leona River.” (2 points) 
 

(b) What kind of river is this and what features do you see that tells you this? (3 points)  
 
 
 
 
 
 
 

(c) Rivers of this type are often associated with what climates (not environments!) that have 
what two conditions? (1 point)  

 
 
 

(d) What other geological structures (and the objects that created and occupy them) near these 
coordinates (not including other examples of the kind of structure seen at the coordinates 
above—you will have to zoom out and move around to see the larger picture) provide 
evidence of this year-round climate? Note that a lack of vegetation is not a geological 
structure! (2 points) 

 
 
 
 
 
 
 
(e) From the “Edit” menu, choose “Copy Image” to copy a picture of your view of one such 

structure; then paste the copied image into your Microsoft Word document and label it: 
“3e) Other Evidence.” (2 points) 

 
 
 
(4) (a) Enter the following coordinates in the search box: 72°52'40.23"N, 126°24'29.42"E and zoom 
to an eye altitude of about 450 mi. You are on the northern border of Russia and looking at the 
place where the enormous Lena River empties into the Laptev Sea (which is part of the Arctic 
Ocean). From the “Edit” menu, choose “Copy Image” to copy a picture of your view; then paste 
the copied image into your Microsoft Word document and label it: “4a) Lena + Laptev.” (2 points) 
 

(b) What kind of sedimentary structure is present here? (1 point)  
 

(question continues on the next page)  
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(c) What features can you see within this structure that provides evidence that this is the kind 
of structure you indicated above? (You may want to zoom in and look around more closely 
at this area to answer this question.) (2 points)  

 
 
 
 
 
 

(d) From the “Edit” menu, choose “Copy Image” to copy a picture of such supporting 
evidence; then paste the copied image into your Microsoft Word document and label it: 
“4d) Supporting Evidence.” (2 points) 

 
(e) Label on the picture several specific examples of the kinds of features that tell you your 

answer for question #4c. (2 points) 
 
(5) (a) In the Search box, type in “Winter Haven, Florida,” and fly there. Zoom to an eye altitude 
of about 130 mi. You are in central Florida. Note the huge proliferation of roughly circular lakes in 
this vicinity. From the “Edit” menu, choose “Copy Image” to copy a picture of your view; then 
paste the copied image into your Microsoft Word document and label it: “5a) Florida.” (2 points) 
 

(b) Over the course of your geology lectures, you will have learned about two possible 
geological processes that could have created the concentration of rounded depressions 
such as the ones you see in this area (which may or may not have water in them). What are 
the two processes and the names of the pock-marked terrains each one creates? (1 point 
each; 2 points total)  

 
 
 
 
 

(c) Move, zoom, and/or pan around this area to get a better look at the larger surface feature 
structures of the area. Based on what you can (and, perhaps more importantly, what you 
cannot) see, you should be able to rule out one of the two possible processes you listed in 
question #5c. What other features are present—or absent—here that help you rule one out? 
Note that you must also address the possibility of past processes existing in the area as well 
as present processes! (2 points)  

 
 
 
 
 
 

(d) Having ruled one out, which one is more likely? (1 point)  
 
 

(question continues on the next page)  
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(e) What kind of rock must be at and below the surface in this area? (1 point)  
 
 
 

(f) What is the name for this kind of topography? (1 point) 
 
 

(g) What has happened to this rock in this area to create these structures? Be specific and 
detailed—your answer should be more than a few words long! (4 points)  

 
 
 
 
 
 
 
 
 
 
(6) (a) In the Search box, type in “Yangshuo, Guilin, China” and fly there. The small city of 
Yangshuo sits on the Li River in the northeastern part of Guangxi Province, southern China. This 
town is a hub for international tourism because of the highly unusual mountains in this area. Zoom 
to an eye altitude of about 40,000 ft. Describe in your own words the general shapes, layout, and 
distribution pattern of the mountains in this area that you can see in this view. (3 points) 
 
 
 
 
 
 
 
 
 
 

(b) Pick a spot somewhere amid these mountains just outside of Yangshuo and zoom to a very 
low eye altitude, about 700 ft. (the picture will become very blurry as you do this, but hold 
on a minute!). Once at this low altitude, pan up so you have a more or less horizontal 
view—as if you were standing on the valley floor and looking up at the surrounding 
mountains. Pivot your view 360° and observe the individual mountains as you do so. 
Describe in your own words the (in general) shapes of the individual mountains you see in 
this area. (2 points) 

 
 
 
 

(question continues on the next page)  
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(c) Stay at this altitude and at this view angle. Move around the area, moving up some of the 
valleys between peaks. Many of the peaks—called fengcong (as conical peaks with 
connected bases) and fenglin (as isolated, often cylindrical peaks)—in this area have bizarre, 
unusual shapes. Find one such mountain and, from the “Edit” menu, choose “Copy 
Image” to copy a picture of your view; then paste the copied image into your Microsoft 
Word document and label it: “6c) Yangshuo.” (2 points) 

 
(d) This region is an extreme example of the phenomenon you saw in Florida in question #5. 

What type of rock must comprise these mountains? (1 point) 
 
 
 

(e) As cool as Google Earth is for seeing things like this, it simply cannot do this popular 
tourist destination any justice compared to real photos. Perform a Google image  search for 
“Yangshuo Mountains” and find a good photo of what these mountains really look like. 
Copy and paste that photo into your Microsoft Word document and label it: “6e) Real 
Yangshuo.” (2 points) 

 
(f) How do the shapes of these mountains as seen in the photo compare with how you 

described them in question 6b? (1 point) 
 
 
 
 
 
 
 
 

(g) Given that these form in the same way as the features you saw in Florida in question #5 and 
from the same rock type, why do fengcong and fenglin look so radically different than what 
you saw in Florida? Two good sources of information on this are at 
http://www.speleogenesis.info/directory/karstbase/pdf/seka_pdf9840.pdf (especially see Fig. 
19 on p. 10) and http://www.chinaspree.com/china-travel-guide/china-guizhou-guangxi-
tours.html (see the second-to-last diagram near the bottom of the page). Note that the word 
“doline” used on some of these pages is another word for “sinkhole.” (3 points) 

 
 
 
 
  

http://www.speleogenesis.info/directory/karstbase/pdf/seka_pdf9840.pdf
http://www.chinaspree.com/china-travel-guide/china-guizhou-guangxi-tours.html
http://www.chinaspree.com/china-travel-guide/china-guizhou-guangxi-tours.html
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(7) (a) Enter the following coordinates into the Search box: 54°28'16.68"N, 160°10'6.96"E, and fly 
there. You are on the Kamchatka Peninsula of remote northeastern Russia, in part of Siberia, very 
close to the Pacific Ocean. Zoom to an eye altitude of about 32,000 ft.—the view will be rather 
blurry. You are looking at the valley of the Geisernaya River, an area so remote that it was not 
systematically explored until the 1970s. This area is renowned for having a specific feature in it that 
in Russian is called Dolina Geiserov. Open a web browser and search for this name. What is the 
English name for this area? (1 point) 
 
 
 
 

(b) Why is this area special? (2 points) 
 
 
 
 

(c) Only one other place in the world has more of the features that make Dolina Geiserov 
special—where is that place? (1 point) 

 
 
 
 

(d) The features that make Dolina Geiserov famous are created by what processes happening 
beneath the ground in this area? (2 points) 

 
 
 
 
 
 

(e) This part of Kamchatka has many other structures created by the same larger processes 
that create the Dolina Geiserov. In Google Earth, pan up and move around the area to find 
one such structure that has a name. In the “Layers” menu in the lower left of the Google 
Earth Window is a “Borders and Labels” menu. Within that is a “Labels” submenu, and in 
that is a “Geographic Features” option. Check the box next to that, and green “mountain” 
symbols will appear on many of these structures at this location. Hover the cursor over any 
one to see the name, and click on it to see more information about the structure. From the 
“Edit” menu, choose “Copy Image” to copy a picture of your structure; then paste the 
copied image into your Microsoft Word document and label it: “7d) Kamchatka.” (2 
points) 

 
(f) What is the name of this structure and what kind of structure is it? (2 points) 
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NOTES FOR STREAMS AND GROUNDWATER 
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LAB #9 
EOLIAN AND GLACIAL 
ENVIRONMENTS AND 
MASS WASTING   

Giant sand dunes of the Kumtag Desert (part of the larger Taklamakan Desert) outside the city of Dunhuang in 
Gansu Province, western China. Dunhuang was a critical stop along the ancient Silk Road trade route. The 
famous Mogao Grottoes lie in the desert just outside the city. Photo by Jerry D. Harris. 
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 The purpose of this exercise is to give you some experience recognizing surface features 
created by eolian and glacial processes and by some kinds of mass wasting events. Because (a) all 
of these are global phenomena, (b) many are uncommon in our vicinity and therefore difficult to 
see firsthand, and (c) seeing them well requires gaining a lot of altitude, you will instead use Google 
Earth to examine and explore several such features in various places around the world. 
 
Key Learning Points: 
 

• Recognizing various eolian features, glacial landforms, and mass-wasting-created surface 
features. 

• Using Google Earth as a tool to locate and examine specific places. 
 
 
 
 
This exercise is worth 75 points; point values for each question are given at the end of each 
question. 
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 For this exercise, you will be using the free, stand-alone (not web-based) program Google 
Earth to virtually “visit” various geographic locations around the planet in order to see and identify 
geological structures that were created by the surface processes of streamflow and groundwater. 
Google Earth uses a collection of satellite photos to depict the entire surface of the planet, much of 
it in 3D. You will need a computer (either PC or Mac); if Google Earth is not already installed on 
it, go to http://earth.google.com to download its installer; you will need to run that installer after it 
has downloaded. You will be doing part of the exercise in Microsoft Word, so your computer 
must have that installed as well (or another program into which you can paste pictures and label 
them). 

 In case you have never used Google Earth before, on the next page is a brief overview of its 
basic controls (the ones you will need for this exercise) and how to use them. Before doing this 
exercise, you should spend some time practicing with the different controls so that you know how 
to use them and know what they do—to answer some of the questions on this exercise, you will 
need to be able to use the controls in complex ways!  Try, for example, finding your house, or 
Dixie State College. Fly deep into Grand Canyon and look up at its walls as if you were standing 
down in the Colorado River in its bottom. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://earth.google.com/
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In addition to these controls, here are some other useful things: 

• You can zoom into any spot simply by double-clicking on it on the map (whether or not there is a label on it). Note that only in the continental 
United States is the resolution pretty high at low altitudes; elsewhere in the world will be blurry very close up. 

• The cursor, when over the map, turns into a hand; you can click and hold the hand (which turns into a fist) and drag the view in any direction. 
• If, when dragging a view, you let go while it’s moving, it will “coast” on its own; just click anywhere in the picture to stop it. 
• You need to know north, east, south, and west. Knowing what longitude and latitude are will be helpful, too. 

 

Fly—after entering text into the Search box, click this 
magnifying glass to fly to the location you entered. 

Layers—use the 
check boxes in this 
window to turn on 
various features. For 
this exercise, the only 
one you will want 
checked will be 
Borders; having any 
others on will clutter 
up your view, though 
some of the Photos 
are very cool! 

Eye Altitude—this 
tells you how high 
you are above the 
surface you are 
looking at. (If this 
isn’t showing, make 
sure “Status Bar” is 
checked in the 
“View” menu. 

Search—type (or cut 
and paste) text, such 
as coordinates 
(latitude, longitude) 
or names of places 
into this box. 

Zoom—use this 
slider bar to zoom 
in (+) or out (-). 

Move—use the 
arrows in this circle 
to move north, east, 
south, or west. 

Compass—you can grab the “N” and rotate it 360º to see 
things from different angles. Double click on the “N” to 
put north back to “up.” 

Coordinates—the latitude and longitude of 
the place you are looking at. 

Pan—use the arrows 
in this circle to pan 
(tilt) or pivot your 
view in different 
ways. 
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IN ADDITION TO THE QUESTIONS IN THIS EXERCISE… 
 
 As part of this exercise, you will be copying some pictures from Google Earth into a 
Microsoft Word document; you will then print out and turn in this document in addition to 
the pages on which you answer the questions in this lab exercise. For this Microsoft Word 
document, do the following: 
 

• Open Microsoft Word at the beginning of this exercise. 
• After pasting pictures from Google Earth into Microsoft Word, you may have to shrink 

the pictures—you will want to have two or three pictures per page (to save paper). To do 
this: 

o Click on the picture in Microsoft Word—a series of white dots (handles) will 
appear at the corners and in the middle of the edges of the picture. 

o Click and hold on any of the corner handles, and drag toward the inner part of 
the picture to make it smaller. Release the handle by lifting your finger off the 
mouse button to keep it at its appropriate size. Please keep it at a size in which 
its contents are visible! 

o Once at an appropriate size, you can move the picture around the page. 
o Create labels for your pictures below the pictures themselves. You can do this 

by entering a bunch of carriage returns (pressing “Enter” or “Return” several 
times) until the cursor is below the picture; then type your label. There are 
other ways of doing this, too, and you are welcome to use them if you know 
them. 

o Please put a few extra carriage returns between your pictures! 
• Save your document often, or else you may end up having to redo it from scratch! 
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(1) (a) In the search box, type “Hellesylt, Norway” and fly there. Zoom to an elevation of about 12 
mi. This village sits on the southwestern edge of a long, watery geological structure, which is the 
subject of this question. From the “Edit” menu, choose “Copy Image” to copy a picture of your 
view; then paste the copied image into your Microsoft Word document and label it: “1a) 
Hellesylt.” (2 points) 
 

(b) There are several lines of evidence that indicate what this structure is. One of these is the 
latitude of this area. Is the latitude high or low? (1 point)  

 
 
 
 

(c) What, therefore, would you expect the climate in this area to be? (1 point)  
 
 
 

(d) Pick a point inside this structure just a little northeast of Hellesylt, slightly past the fork. 
Zoom in to an eye altitude of about 500 ft. so that you are basically sitting deep inside this 
structure. Pan around so that you are looking northeast (away from Hellesylt), along the 
long structure. From the “Edit” menu, choose “Copy Image” to copy a picture of your 
view; then paste the copied image into your Microsoft Word document and label it: “1d) 
Hellesylt Structure.” (2 points) 

 
(e) Another indicator of what this structure is its cross-sectional shape. What is this 

characteristic shape? (1 point)  
 
 
 

(f) What is the name of this kind of structure, and what created it but is no longer present 
here? (2 points)  

 
 
 
 
 
 
 
 
 

(question continues on the next page)  

Name:___________________________________________  Lab Section:________________________ 
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(g) Zoom way out from Hellesylt to an eye altitude of about 60 mi. Move directly to the east 
(the best way is to use the right arrow key on the keyboard). You are now entering Sweden. 
Once you get out of the mountainous area, you’ll pass an area with a few rows of small, 
fluffy clouds. East of this, notice that there are many, many lakes in this area. Based on the 
evidence you saw for the structure at Hellesylt, and based on what you know must have 
created it, what kinds of lakes must these therefore be? (1 point) 

 
 
 
 

(h) From the “Edit” menu, choose “Copy Image” to copy a picture of your view of these lakes; 
then paste the copied image into your Microsoft Word document and label it: “1h) 
Finland.” (2 points) 

 
 
 
(2) (a) Enter the following coordinates3 in the search box: 53°56'6.81"N, 128°16'54.84"W, and fly 
there. Zoom to an eye altitude of about 20 mi. You in the Canadian Rocky Mountains in British 
Columbia; these coordinates lie in a valley bordered on the north by Cobalt Peak (among others). 
From the “Edit” menu, choose “Copy Image” to copy a picture of your view; then paste the copied 
image into your Microsoft Word document and label it: “2a) British Columbia.” (2 points) 
 

(b) The series of long, parallel features on the south side of the valley are interesting. Zoom 
way in to an eye altitude of about 13,000 ft. and rotate your view so that the valley runs 
straight up and down in your view and north is off to the left. Now zoom in even farther, 
down to an eye altitude of about 5000 ft. Now you are well within the valley. Pan up and 
rotate your view so you can look at the side valleys on the south side of the main valley 
(now on your right). These side valleys are examples of a specific kind of valley. What 
kinds of valleys are these? (2 points)  

 
 
 
 

(c) From the “Edit” menu, choose “Copy Image” to copy a picture of your view; then paste the 
copied image into your Microsoft Word document and label it: “2c) Side Valleys.” (2 
points) 

 
(question continues on the next page)  

                                                           
3 To type a degree symbol on a Windows PC, hold down the “Alt” key and, on the keypad (not the numbers across 
the top of the keyboard!), type 0176. On a Mac, hold down the “Option” or “Alt” key and type 0. 
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(d) Now move up one of these side valleys until you reach its head. Pan you view downward so 
it is at an angle to the ground surface (but not vertical), and zoom out a little bit to get a 
better view of the head of the valley. What kinds of features are at the heads of these side 
valleys? (1 point)  

 
 

(e) From the “Edit” menu, choose “Copy Image” to copy a picture of your view; then paste the 
copied image into your Microsoft Word document and label it: “2e) Valley Head.” (2 
points) 

 
(f) What are the ridges that separate these side valleys from one another? (1 point)  

 
 
 
 
 
(3) (a) Enter the following coordinates in the search box: 35°52'53.91"N, 76°30'46.22"E and fly 
there. Zoom to an eye altitude of about 11 mi. You are on a particular mountain in the Karakoram 
Mountain range (part of the Himalayas) the border between Pakistan and China. Zoom in 
alongside (not on!!) the mountain to an eye elevation of about 28,000 ft., and then pan up so you 
can look at it from the side in a more horizontal view. From the “Edit” menu, choose “Copy 
Image” to copy a picture of your view; then paste the copied image into your Microsoft Word 
document and label it: “3a) Karakoram.” (2 points) 
 

(b) Pan and move around the mountain to view it from several different sides (that is, see many 
different sides of this mountain). From the “Edit” menu, choose “Copy Image” to copy a 
picture of an angle you find particularly interesting or appealing (different from your first 
one); then paste the copied image into your Microsoft Word document and label it: “3b) 
Mountain.” (2 points) 

 
(c) Based on its shape, what kind of mountain is this? (1 point): 

 
 
 

(d) What other geological evidence in the vicinity of this mountain is there that supports your 
interpretation in question #3c? (1 point) 

 
 
 

(question continues on the next page)  
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(e) This particular mountain is special for a good reason. In the “Layers” menu in the lower 
left of the Google Earth Window is a “Borders and Labels” menu. Within that is a 
“Labels” submenu, and in that is a “Geographic Features” option. Check the box next to 
that, and a green “mountain” symbol will appear on the mountain at this location. Hover 
the cursor over it to see the name of this mountain; you can also click on it to see more 
information. What is the mountain’s name and why is this mountain special? (2 points) 

 
 
 
 
 
 
Turn off (uncheck) the “Geographic Features” and “Labels” function after you have answered this 
question. 
 
 
(4) (a) Enter the following coordinates in the search box: 24°21'43.24"S, 15°7'29.12"E and fly there. 
Zoom to an eye altitude of about 130 mi. You are in Namibia, which is in southwestern Africa. 
From the “Edit” menu, choose “Copy Image” to copy a picture of your view; then paste the copied 
image into your Microsoft Word document and label it: “4a) Namibia.” (2 points) 
 

(b) Zoom in farther, down to an eye altitude of 2500 ft. or less, and pan around to get a more 
horizontal view. What features are you seeing in this region? (1 point)  

 
 

(c) What force created these features? (1 point)  
 
 
 
 

(d) What is the name for the kind of environment dominated by this force? (1 point) 
 
 
 
 
 

(e) What must the climate be in this area? (1 point)  
 
 
 

(question continues on the next page)  
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(f) From the “Edit” menu, choose “Copy Image” to copy a picture of some of these features 
in your close-up view; then paste the copied image into your Microsoft Word document 
and label it: “4f) Namibia Close-up.” (2 points) 

 
 
(5) (a) Enter the following coordinates in the search box: 50°38'31.48"N, 1°26'20.95"W and fly 
there. Zoom to a low eye altitude of about 900 ft. You are looking at a portion of the southern 
coastline of the Isle of Wight, England. From the “Edit” menu, choose “Copy Image” to copy a 
picture of your view; then paste the copied image into your Microsoft Word document and label 
it: “5a) Isle of Wight.” (2 points) 
 

(b) The cliffs at this location are weathering relatively rapidly, and a particular kind of mass 
wasting event can be easily seen here—what kind is it? (1 point)  

 
 
 

(c) What characteristics do the cliffs here exhibit that tell you what kind of mass wasting event 
this is? (1 point)  

 
 
 
 
 

(d) Zoom in and/or pan around to get a good view of these features (the 3D is not good at this 
location), then, from the “Edit” menu, choose “Copy Image” to copy a picture showing 
these characteristics into your Microsoft Word document and label it “5d) Mass Wasting.” 
Put in arrows pointing to three specific examples of this kind of mass wasting in progress (5 
points) 
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(6) (a) Enter the following coordinates in the search box: 38°5'35.70"N, 119°26'44.57"W and fly 
there. Zoom to an eye altitude of about 21,000 ft. You are in Yosemite National Park, in the Sierra 
Nevada Mountains of California. From the “Edit” menu, choose “Copy Image” to copy a picture 
of your view; then paste the copied image into your Microsoft Word document and label it: “6a) 
Yosemite.” (2 points) 
 

(b) On the east flank of this mountain is a light-grayish area that marks the site of a particular 
kind of mass wasting event. Zoom in close on this feature to get a better idea of what 
materials make up the wasted event. What kind of mass wasting event has occurred (and is 
still occurring!) here? (1 point)  

 
 
 

(c) From the “Edit” menu, choose “Copy Image” to copy a picture of your close-up view; then 
paste the copied image into your Microsoft Word document and label it: “5c) Mass 
Wasting” (at low altitude, it will be a bit blurry). (2 points) 

 
(d) What characteristics can you see here that tell you what kind of mass wasting event this 

was? (2 points)  
 
 
 
 
 
(7) (a) In the search box, type “Nova Friburgo, Brazil” and fly there. Zoom in to an elevation of 
about 12,000 ft. From the “Edit” menu, choose “Copy Image” to copy a picture of your view; then 
paste the copied image into your Microsoft Word document and label it: “7a) Brazil.” (2 points) 
 

(b) At the northern end of this town, where it narrows into a valley, are several brownish scars 
on the sides of the surrounding hills that were created during several examples of a 
particular kind of mass wasting event. Zoom in close on one or more of these to get a 
better idea of what materials make up the wasted events. What kind of mass wasting events 
occurred here? (1 point)  

 
 
 
 

(question continues on the next page)  



 144 

(c) From the “Edit” menu, choose “Copy Image” to copy a picture of your close-up view; then 
paste the copied image into your Microsoft Word document and label it: “7c) Mass 
Wasting” (at low altitude, it will be a bit blurry). (2 points) 

 
(d) What characteristics can you see here that tell you what kind of mass wasting event this 

was? (2 points)  
 
 
 
 
 
 
 
 
(8) (a) Enter the following coordinates in the search box: 51°24'16.89"N, 1°58'9.96"W and fly there. 
Zoom to an eye altitude of about 1900 ft. You are near the picturesque hamlet of Calstone 
Wellington in Wiltshire, England. Notice that the hillsides in this area all have a rippled 
appearance. From the “Edit” menu, choose “Copy Image” to copy a picture of your view; then 
paste the copied image into your Microsoft Word document and label it: “8a) Wiltshire.” (2 
points) 
 

(b) Note that you are fairly far north here—is the latitude of this area high or low? (1 point)  
 
 
 

(c) What, then, would you expect the average annual temperature to be in this area? (1 point)  
 
 
 
 
 

(d) Given this, zoom in and pan around, looking more closely at the “rippled” areas (it may 
help to zoom in to near ground level and look up at them as if you were standing below the 
hills). Do the orientations of the ripples share anything in common—that is, do they all 
point in a common general direction with respect to the surrounding elevations and 
features? If so, what is this common orientation? (2 points)  

 
 
 
 

(question continues on the next page)  
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(e) This rippling is actually an example of a type of slow mass wasting event involving the soil at 
the surfaces of the hills in this area. What is the name of this kind of mass wasting event 
(not the name of the process)? (1 point)  

 
 
 
 

(f) What causes this kind of mass wasting event? (1 point)  
 
 
 
 
 
 
(9) (a) Examine the funky rocks in the photographs below: 
 

Photo credits (clockwise from upper left): 
http://farm1.static.flickr.com/211/452042967_10fa70673a.jpg, 
http://images.publicradio.org/content/2009/01/29/20090129_antarctica_2_0
40_33.jpg, 
http://3.bp.blogspot.com/_1CweQZAAl2o/TPjAAgRV0dI/AAAAAAAAB
Uk/_q6YqQfh5aU/s1600/P1020118.JPG, and http://lh6.ggpht.com/-rUQLX4zZPdc/T9CHDItJzxI/AAAAAAAAYhY/4rtlR3fE4Wk/McMurdo-
dry-valleys-9%25255B6%25255D.jpg. 

http://images.publicradio.org/content/2009/01/29/20090129_antarctica_2_040_33.jpg
http://images.publicradio.org/content/2009/01/29/20090129_antarctica_2_040_33.jpg
http://3.bp.blogspot.com/_1CweQZAAl2o/TPjAAgRV0dI/AAAAAAAABUk/_q6YqQfh5aU/s1600/P1020118.JPG
http://3.bp.blogspot.com/_1CweQZAAl2o/TPjAAgRV0dI/AAAAAAAABUk/_q6YqQfh5aU/s1600/P1020118.JPG
http://lh6.ggpht.com/-rUQLX4zZPdc/T9CHDItJzxI/AAAAAAAAYhY/4rtlR3fE4Wk/McMurdo-dry-valleys-9%25255B6%25255D.jpg
http://lh6.ggpht.com/-rUQLX4zZPdc/T9CHDItJzxI/AAAAAAAAYhY/4rtlR3fE4Wk/McMurdo-dry-valleys-9%25255B6%25255D.jpg
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All of these photographs were taken in the vicinity of the following coordinates: 77°28′0″S, 
162°31′0″E. Enter these coordinates into the “Search” box and fly there. Zoom to an eye altitude 
of about 130 mi. You are on the floor of the Dry Valleys area of McMurdo, Antarctica, one of the 
few non-glaciated places on the entire continent. From the “Edit” menu, choose “Copy Image” to 
copy a picture of your view; then paste the copied image into your Microsoft Word document and 
label it: “9a) Antarctica.” (Sadly, the resolution of the satellite photos in this area is not good 
enough to allow you to zoom in and see rocks like these in the area.) (2 points) 
 

(b) Although the valley you are in was doubtlessly glaciated at points in the past, these rocks 
were not shaped by glaciers. What force was responsible for sculpting these rocks? (1 
point) 

 
 
 
 
 

(c) What is the name of the process that produced the shapes of these rocks? (1 point) 
 
 
 
 
 
(d) What is evidence on the rocks themselves that the rocks were not shaped by glaciers? (2 

points) 
 
 
 
 
 
 
 
 
(e) What kind of environment must this region of Antarctica have, in addition to glaciated? (1 

point) 
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NOTES FOR EOLIAN AND GLACIAL ENVIRONMENTS AND MASS 
WASTING 
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LAB #10 
 
 
 
 
 
 
 
EARTHQUAKES   

Aftermath of the Wenchuan earthquake in Sichuan, China on May 12, 2008. The quake registered 8.0 in magnitude; an 
estimated 68,000 people were killed, primarily by the collapses of buildings constructed cheaply from substandard materials and 
in non-earthquake-resistant ways that would be considered substandard in the U.S.. Photo by Ryan Pyles (from 
http://ryanpyle.com/main.php#/Photography/Sichuan%20Earthquake/1/). 

http://ryanpyle.com/main.php#/Photography/Sichuan%20Earthquake/1/
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 The purpose of this exercise is to provide you with experience in determining information 
about an earthquake after it has happened. You will be using computer simulations of earthquakes 
and seismic waves to, in essence, behave as a geophysicist that has to determine basic information 
about the quake. 
 
Key Learning Points: 
 

• Understanding seismic-wave travel times and S–P lag times. 
• Determining the position of the epicenter of an earthquake using multiple seismographs. 
• Determining the magnitude of an earthquake. 

 
 
 
This exercise is worth 70 points; point values for each question are given at the end of each 
question. 
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 For this exercise, you will need a computer that is hooked up to a printer (color is great, but not necessary). You will be doing a 
web-based exercise, so you will need a web browser program. For some reason, Google Chrome does not seem to like this exercise, so 
please use either Internet Explorer or (preferably) Firefox. If your browser uses a pop-up blocker, please either turn it off before you 
begin or be sure that the URL below is listed as an exception to blocking pop-ups —the exercise site uses pop-ups. I highly recommend 
having no other windows open on your computer as you do this—pop-up windows can be easily lost in a pile! 

 The activities you will do are accessed at 
http://www.sciencecourseware.org/eec/Earthquake. Its introductory screen is shown 
at left. At this site, you will do three things (in this order): 

• Do an exercise to determine the travel time of an earthquake to various 
seismographs; 

• Do an exercise to determine the position of the epicenter of an earthquake and its 
magnitude; and 

• Take a short (10 question) quiz on these topics. 

All work for this exercise will be done on-line, and you will need to print and hand 
in your work and results in order to get credit for this exercise. DO NOT hand in 
the pages from this book; they are only to help guide you through how to do the 
online exercises. Below, you will be instructed on how and what to print out and 
hand in to get credit for this exercise. Watch for the big printer icon—that will be 
your cue that something needs to be printed. 

 

 

 
 

NOTE: Because this exercise uses Java, you may see some unexpected things on the screen. Most prominently, when you hover the 
cursor over a button (or field of buttons), you may see the region outlined, and a little box will pop up that says something like “Click to 
activate and use this control.” Do just that—click once anywhere in the outlined field, and then the buttons will work as you would expect. 

= TIME TO PRINT SOMETHING! 

http://www.sciencecourseware.org/eec/Earthquake
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EARTHQUAKE TRAVEL TIME EXERCISE 
 

 The purpose of this exercise is to use the lag time between the arrivals of P waves and S waves at a seismograph in order to figure 
out where the epicenter of an earthquake was—remember that P waves travel 1.7 times as fast as S waves, so at any seismograph, P waves 
will be received first and S waves second; the difference between when these waves are received is called the S–P lag time. To review this 
concept, it will be well worth your while to do the “S–P lag Time” Tutorial available at the site—it will only take you a few minutes.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

S–P Lag Time Tutorial button 

Latitude–Longitude 
Tutorial button 
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Here’s what the tutorial will look like (once you click the “Start” button): 

 
 

 

Run through the site’s Demonstration of this exercise before you 
begin—it will walk you through how the site works. You can 
access this Demonstration by clicking on the “Demonstration” 
button on the introductory screen. When you are ready to do 
the exercise, click on the “Travel Time” button. 

 

 

 

 

 

explosion (simulates 
earthquake epicenter) 

S wave 
(blue) 

P wave 
(red) 

seismograph 

seismogram (drawing that 
appears on the seismograph as 
waves are received) 

CLICK HERE to see how S–
P lag time differs between two 
seismographs at different 
distances from the epicenter 

Demonstration 
button 

Travel Time 
Exercise button 

Epicenter & 
Magnitude 
Exercise button 
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Once you click on the “Time Travel” button, a pop-up window will appear (if it does not, make sure your pop-up blocker is turned off!). 
Click on the “Start” button in this window to begin the exercise, and this is what you will see: 

STEP 1: Put your name in the Name field (you will have to click in the 
blank box to put the cursor there). 

STEP 2: Note the “Tasks” box that dominates the top of the window; the 
bottom part of the window, where you will record your data, is the 
Journal area. Items highlighted in gold are things you have to do, and 
you’ll do them in the order presented. Hovering the cursor over a gold-
highlighted button tells you what the button does. Click on the gold 
highlighted button to perform that task. (Note the matching icons in the 
upper right—you can go back to any part of the activity by clicking on the 
appropriate button.) Also note the empty data fields for “S–P Lag Time” 
and “Distance” at the bottom—you will fill these in as you go through the 
exercise. Click on the “Move Stations” button. 

STEP 3: An aerial photo appears at the top of the window. The 
numbered, red boxes in the lower left—these are your seismographs. The 
blue circle with the “E” at the top is where the earthquake epicenter will 

be. Use the mouse to drag your five seismographs (red squares) to different positions on the photo—they should all be in very different, 
widely separated positions from each other and different distances 
from the epicenter; don’t cluster any of them near each other. Once 
they are in the positions you want, click on the “Trigger Explosion” 
button in the upper right to create the earthquake. Once the quake is 
over, you will return to the Tasks list. 

STEP 4: Now you have to measure and record the S–P lag times and 
distances to fill in the data fields at the bottom. Click first on the “S–P 
button. You will see the seismogram recorded at your first seismograph 
station (the number in upper left). If the squiggles you see are either 
really small or really big, change the zoom (scale) using the pull-down 
menu in the upper right. Use the mouse to drag from the indicated point (at the reception of the first P wave) to the reception point of 
the first S wave. This will highlight the distance between the two in red; the time (in seconds) is given at the lower right corner of the red 
box that appears as you do this. Enter this time in the datum field at the bottom of the window. Repeat this for the other four 
seismograms. 

switch between your 
five seismographs 

measure S–P lag time here 
zoom in or out 
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STEP 5: Click on the “Distance” button in the cluster of buttons in the upper right. This returns you to the aerial photo and layout of 
your seismographs. For each seismograph, use the mouse to drag the orange circle so that part of the circle goes through the middle of 
each of your numbered stations. As you do this, the distance from your station to the epicenter (“E”) appears next to your cursor—this is 
the radius of the circle you are drawing. Record this datum in the appropriate fields at the bottom of the window for each of the five 
seismographs. 

STEP 6: Notice that the Journal field has a scroll bar. Once you 
have filled out all the fields, scroll down a little bit to reveal a 
“Verify Data Table” button. Click this to see if your data are 
accurate. If they are, click “OK” in the box that pops up to tell 
you so and return to the Tasks list; if not, go back and adjust your 
data as needed and repeat this step. 

STEP 7: Now you will create a graph of your data. Click on the 
“Point Plotter” button. The top of the window turns into a graph. 
At the right of the graph is a table of your data; each seismograph 
is represented by a red dot. Use the mouse to drag each dot to its 
appropriate place on the graph. When you place the last dot, a 

button will appear asking you to verify if your placement is accurate. 
Click this; if your points are correct, click “OK” to return to the Tasks 
list and go to Step 8. If not, readjust your dots as needed and re-verify. 

STEP 8: Now you have to fit a line to a graph of your S–P lag times. 
Click on the “Fit Line” button. In the graph part of the window that 
appears, drag the blue line so it makes the best possible fit to all the 
dots. When you are done, click on the “Verify Slope” button. This may 
tell you to adjust your line to a better fit; when your fit is acceptable, 
click “OK” in the pop-up window that appears and return to the Tasks 
list. 

STEP 9: There are two questions to answer below your data fields in the Journal area; scroll down to them. Then click on the “Travel-
Time” button to reveal another graph that you will need to answer the two questions. On the graph, you can use the mouse to drag the 
red lines up and down the blue line to get the answers you need. (The questions and answers will be different for everyone!) After you 
have entered your answers in the blank boxes, scroll down to and click on the “Verify Answers” button. If your answers are good, click 
“OK” in the pop-up window that appears. 
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STEP 10: Now you will need to print your answers as part of what 
you will hand in for this exercise. Click the “Print” button in the 
upper right of the window. A pop-up will ask you what you want to 
print. You will need to hand in print-outs of your Map and your 
Journal (the data fields). Note that it will tell you to print the map 
in “Landscape” format, so in the Printer dialog 
box that appears, be sure to tell your printer to 
do this (how to do this depends on the printer; if 
there’s no option in the main dialog box, click on 
the “Properties” button in it; it’s probably in 
there).  

STEP 11: Click “Quit” in the upper right to close this window and 
return to the main window. Don’t worry about saving the data 
unless you want to (as a backup or to print somewhere else). 

 

EPICENTER & MAGNITUDE EXERCISE 
 In this exercise, you will determine the position of an earthquake’s epicenter and the magnitude of the quake on the Richter scale 
(which has not actually been used as a means of measuring earthquake magnitudes since the 1970s…but it’s the process that’s important 
because the scale that is used now uses a similar process). Part of this exercise will involve reading latitude and longitude from a map; if 
you are not familiar with how to do this, do the short “Latitude/Longitude” Tutorial available via a button on the main screen; you might 
also benefit from visiting http://geography.about.com/cs/latitudelongitude/a/latlong.htm or http://www.phy6.org/stargaze/Slatlong.htm—
you’ll probably want to open this in a new window or tab so you don’t lose all your work!). When you are ready to begin the exercise, 
click on the “Epicenter & Magnitude” button in the main screen. An introductory screen will appear; in it, click “Start Activity.” 

STEP 1: As before, a pop-up window will appear in which you will do the exercise; its layout is similar to the one for the S–P lag time 
part of the exercise. Put your name in the Name field near the bottom. 

http://geography.about.com/cs/latitudelongitude/a/latlong.htm
http://www.phy6.org/stargaze/Slatlong.htm
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STEP 2: Click on the “Choose an earthquake” button. 
In the resultant screen, notice that in the “Instructions” 
box in the lower right you can choose from one of three 
locations: southern California, northern California, and 
Utah; you can also choose a random location. Any of 
these will do. The aerial photo you get will appear in the 
top of the window, along with several numbered (red 
boxes) seismographs. 

STEP 3: Click the “Trigger Earthquake” button at the 
top. Once the quake is over, the window will return to its 
Tasks list. 

STEP 4: Click the first of the two “Measure S–P lag 
times and Amplitudes” buttons (the one with the 
horizontal bar in it). The screen that appears is similar to 
the one you saw in Step 4 of the last part of the exercise, 
and it works the same way. The only difference is that 
now, in your data fields at the bottom, there’s only room 
for data from three seismographs, so you can pick 
whichever ones you want from the pull-down menu in 

the upper left. (The zoom menu may also be helpful here, too.) Be sure to record the station number along with your data!  

STEP 5: When you are done with Step 4, click on the vertical bar button (below the “E” button) in the button collection in the upper 
right. The seismogram window will change somewhat; here you will measure the amplitude of your seismogram. The amplitude is the 
height of the waves recorded on the seismogram. Use the mouse to drag the red measuring bar up or down to the highest point (the 
strongest wave)—it measures from the midline to that peak in millimeters. Record this datum for each of the same three seismographs 
you used in Step 4. NOTE: for some seismograms, even the lowest zoom value won’t allow you to see the peaks; if this happens, the 
exercise will tell you so and ask you to pick a different station. If you have to do this, you will also have to go back and change the S–P lag 
time number to match the new station (click on the horizontal bar button in the upper right to do this). 

STEP 6: Now you will need to find the distances of each of your three seismographs to the quake epicenter. Click on the “Travel-Time” 
button (the one with the L-shaped graph) in the upper right. This will make a graph appear in the top of the window. It works the same 
way the one in Step 9 of the previous part of the exercise did: drag the red measuring bars up and down the blue line to get the distances 
(in km) that correspond to your S–P lag times. Record these data for your three seismographs. 
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STEP 7: Now you will make a map of the epicentral circles for 
each of your stations. An epicentral circle is a circle drawn around 
a seismograph (which is at the center) and whose radius equals the 
distance to the epicenter of the quake. Click on the “Epicentral 
Circle” button in the upper right (the one with three overlapping 
circles on it). This returns you to your aerial photo, and tells you 
to drag the orange circles out to the distances you recorded in the 
previous step. Be sure that you do this for the same three stations 
for which you got your data! (Ignore the other stations.) When you 
are done, all three circles should overlap at one common point—
this point is the epicenter of the earthquake. 

STEP 8: Now you need to figure out the position of the epicenter. 
Click on the “Locate Epicenter” button (the one with the small “E” in 
a circle) in the upper right. You will still have your aerial photo and 
epicentral circles up, but now there is an “E” in a blue circle that you 
must drag to the epicenter. 

STEP 9: To figure out the position of the epicenter, click on the 
“Latitude/Longitude” button (the globe in the bottom center of the 
button field in the upper right). Again, you still have your aerial photo, 

but now it is overlain by latitude and longitude lines. Using this, 
estimate the position of your epicenter and record this datum in the 
appropriate blanks in the bottom of the window (you may have to 
scroll down to see these fields) in degrees (°)* and minutes (′). Note 
that the divisions used in this map are in quarters of a degree; recall 
that a degree can be divided into 60 minutes. Don’t forget to note 
N, S, E, or W! 

 

* To type a degree symbol on a Windows PC, hold down the “Alt” key and, on the keypad (not the numbers across the top of the keyboard!), type 0176. On a 
Mac, hold down the “Option” or “Alt” key and type 0. 
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STEP 10: Lastly, it is time to figure out the magnitude of 
your earthquake on the Richter scale (which, recall, is no 
longer used—however, the procedure for determining 
the magnitude is the same in the moment magnitude 
scale!). To do this, you will use a chart called a 
nomogram that uses your distance and amplitude data to 
determine the magnitude of the quake. Click on the 
“Magnitude” button in the upper right (the one with 
three offset vertical bars). The nomogram you see at left 
will appear. Drag the red lines on both sides to the 
appropriate positions for the data from each of your 
three seismographs. Note that as you do this, numbers 
in red at the ends of each line change to show you the 

exact value on the graph that the line is sitting on. Once the distance and amplitude lines are in position, you can see where the red line 
crosses the Richter Magnitude graph in the middle. Record the magnitude for each one in the appropriate field. 

STEP 11: Click on the “Verify Answers” button in the bottom of the Journal area to see if you have correctly obtained all the data. If you 
have not, make the appropriate changes in the appropriate fields (use the buttons in the upper right to get to individual screens). 

STEP 12: If your data are all good, you will need to print out your data as part of what you will hand in. Click the 
“Print” button in the upper right; as before, print the Map and the Journal. 

 When you are done, click “Quit” in the upper right. When you do this, a new browser window should open 
and tell you that you have successfully completed the activity. To move on to the quiz, click in this window where it 
says “Click HERE to continue.”  



 161 

QUIZ 
 After clicking as above, the new window will change and ask you to 
enter your name, Institution, Location, and Class Code. The Code you 
will need to enter is 1021386. The quiz has 10 questions on five screens; 
all of them ask questions that entail making the same kinds of 
measurements and reading the same kinds of graphs you already did for 
the above exercises. (Question #6 is tricky—read it carefully!) Note that you 
can leave an answer blank, but I don’t recommend it—these questions, and 
your score on the quiz, will count toward your grade on the exercise. 
When you are done, a screen will appear that tells you your score on the 
quiz. This page also has a big pink “Certificate of 
Completion” at the top with your name in it. You 
must print this page (choose “Print…” from the 
File menu) and hand it in with the other sheets 
above as part of your exercise. 

 

Thus, you will be handing in five (5) things:  

 

• the Map and Journal from the Travel Time exercise; 

• the Map and Journal from the Epicenter & Magnitude 
exercise; and 

• the certificate page from the quiz. 
 

Make sure that your name is on at least the first page! 

 

Staple these things together in this order and hand it in on the due date. You will not be handing in the pages from this lab manual! 
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NOTES FOR EARTHQUAKES 
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Lab #11 
PLATE TECTONICS  

The Kamchatka region of northeastern Russia, showing two volcanic arcs where the Pacific Plate is subducting beneath the 
North American and Eurasian plates, creating deep trenches. From Google Earth. 
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 The purpose of this exercise is to provide you with some experience dealing with various 
aspects of plate tectonics. Tectonic plates are immense, and most tectonic activity occurs in 
inaccessible places (such as deep underground). In addition, tectonic movements take place over 
long time scales that cannot be observed in short human time spans (let alone the span of a single 
Introduction to Geology lab!). Therefore, this lab uses (a) computer animations to examine plate 
motions over time, and (b) accepted, scientific web sites that document the results of plate 
movement to connect long-term tectonics and the characteristic features of those movements that 
can be observed on a human time scale. 
 
Key Learning Points: 
 

• Phanerozoic paleogeography and the changing configurations of plates over time, including 
predicting future plate positions and the effects of their movements. 

• The rates at which tectonic plates move, using the equation: 
 

rate = 
distance

time
 

 
• Recognizing different kinds of plate boundaries based on events that occur at those 

boundaries. 
 
 
 
This exercise is worth 80 points; point values for each question are given at the end of each 
question. 
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 For questions #1–6 of this exercise, you will use one of the computers in the classroom to 
play a Flash animation (.swf format) titled “PlateMoTime” (short for “plate motions through 
time”). This animation shows the motions of the Earth’s major plates over the last 600 million 
years (remember, though, that there was plate tectonic activity well before this, too!). When you 
have the animation open, note that there are two buttons at the bottom of the screen: “Continuous 
Play” and “Explanation Pauses.” Both run the animation more or less the same way; the 
“Explanation Pauses” version stops periodically to give you more time to read the snippets of text 
that pop up on the animation, requiring you to manually restart the animation each time it pauses. 
You can run the animation either way for the purposes of this exercise, but you may like the 
“Explanation Pauses” version better just so you can assimilate information better. Click whichever 
of the two buttons you want. After you do this, a control bar will appear beneath the buttons, and 
whichever button you selected will change to read “Main Screen.” 

 On the control bar, click the “Play” button (). While the animation is playing, this button 
turns into a “Pause” button (||). There is also a little hourglass-shaped controller that progresses 
from left to right in the control bar; any time you want, you can click and hold to grab this and drag 
it left to go backward in time or right to go forward in time. Note that the animation progresses in 
different intervals—sometimes it jumps forward 40 million years between scenes; other times, only 
20 or 30 million years; basically, it is designed to show you the significant, major events in tectonic 
history (during the last 600 million years, of course!). Also note that you can hover your cursor 
over the “Legend” button in the upper left of the animation to see what the different colors mean. 
Be very careful to note that the light blue, shallow seas that cover some parts of the continents do 
not necessarily mark boundaries between plates—two plates can be joined into one plate but have 
their former boundary covered by such a shallow sea! This information will be critical to your 
answering some of the questions below. 

 You will also want to find an atlas or globe to help you with this exercise, especially if you 
don’t yet know which continents are which! Maps and a globe are available in the lab, and there 
are many on-line ones available, too. 
 
(1) Advance the animation to 300 million years ago. This is when the various, separate continents—
which have been separate since the single supercontinent of Rodinia split apart several hundred 
million years earlier—assembled into the single supercontinent Pangea. Let the animation play 
from this point—as time goes on, Pangea breaks up into two separate landmasses: a northern one 
called Laurasia, made of today’s North America, Europe, and Asia, and a southern landmass 
called Gondwana, made up of today’s South America, Africa, Australia, India, and Antarctica. Let 
the animation progress from the 300 million year point. When did Pangea begin to split into these 
two smaller landmasses? (4 points) 
 
 
 
(2) Today’s landmass of Eurasia is now a single continent made up of several smaller landmasses 
that came together at different points in time. (2 points each; 6 points total) 
 

(a) When did the main mass of Eurasia (“Siberia” + “Northwestern Europe”) come together (a 
collision that created the Ural Mountains)? 

 
  

(question continues on the next page) 

Name:___________________________________________  Lab Section:________________________ 
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(b) When did today’s southeast Asia (China and surrounding areas) add to the landmass? 
 
 
 

(c) When did India, the newest addition to Eurasia, get added on? 
 
 
 
(3) In the animation, watch North America from around the beginning of the animation. Note that 
for a long time, the distinctive peninsula of Florida isn’t there—it was actually a part of other plate(s) 
and didn’t get attached to North America until later. To what other modern continental 
landmass(es) was Florida once attached, and when did it become part of North America? Be 
careful here to note that when it became attached is not necessarily the time when you first see it! 
(3 points) 
 
 
 
 
 
 
 
(4) (a) When did India become an “island continent” (not connected to anything else)? (1 point) 
 
 
 

(b) What is the landmass to which India was last connected? (HINT: this land mass isn’t a 
continent and isn’t labeled in the animation, and you may have to run the animation to the 
present and use a map or atlas to identify it.) (1 point) 

 
 
 

(c) For how long was India isolated as an “island continent”? (1 point) 
 
 
 
 
 
(5) As continents collide and separate, old oceans close and new ones open. Study the animation 
to observe how the modern-day Atlantic Ocean formed. 
 

(a) Did the entire ocean form at the same time? (1 point) 
 
 

(b) If not, in what order did its parts form? (2 points) 
 

  

(question continues on the next page) 
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(c) When did each part begin to form? (4 points) 
 
 
 
 
 

(d) The motions of which plates formed each part of the ocean? (4 points) 
 
 
 
 

(e) What kind(s) of tectonic movement did these plates undergo during the formation of the 
Atlantic Ocean? (2 points) 

 
 
 
 
(6) In the following exercise, you are going to determine how fast the Atlantic Ocean is spreading 
using past movements of South America and Africa—in short, the rate at which the sea floor is 
spreading. To do this, you will need to use the mathematical formula:  
 

𝒅𝒊𝒔𝒕𝒂𝒏𝒄𝒆 = 𝒓𝒂𝒕𝒆 ×  𝒕𝒊𝒎𝒆 
 
You will want to calculate the rate by measuring a distance and, using the animation, determining 
the time. Thus, you can rearrange the formula above to: 
 

𝒓𝒂𝒕𝒆 =  
𝒅𝒊𝒔𝒕𝒂𝒏𝒄𝒆
𝒕𝒊𝒎𝒆

 

 
First, you need to find a distance. To do this, using a map, atlas, or globe, find two points—one in 
South America, and one in Africa—that used to be more or less a single point when these two 
continents were last connected (that is, two points that used to be approximately zero distance 
apart when the two continents were united). Probably the easiest things to find will be cities on 
those points, but you are welcome to use any other points for which you can find exact location 
coordinates (latitude and longitude, UTM, etc.).  
 

(a) Where/what are your two points? Include the names of the modern-day countries in which 
your points occur. (2 points) 

 
 
South America: 
 
 
Africa: 
 
 

(question continues on the next page)  
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Now you need to figure out how far apart your two points are today in kilometers (km). You can 
do this either by measuring on your map, atlas, or globe (and doing some simple math using the 
scale provided on the globe or map to convert from the units on your ruler to units in the real 
world). Alternatively, you can use a tool, such as the Ruler in Google Earth. To do this, launch 
Google Earth; if you do not see the Ruler tool or the toolbar at the top of the Google Earth 
window, make sure that “Toolbar” is checked in the “View” menu.  
 

 
 
When you click on the Ruler tool button, a small Ruler window will open—in it, make sure that the 
“Line” tab is open and the “Mouse Navigation” box is not checked. With this tool, you can either 
(a) click on the starting point of where you want to measure, then move and click on the end point 
of your measurement line, or (b) click and hold on your starting point, and then drag a line to your 
end point, and release the mouse button. The distance between your two points will show up in 
the Ruler window (be sure to set the units to km!). To turn off the Ruler tool and use the mouse to 
move to a new position on the globe or type in the Search box, check the “Mouse Navigation” 
button. (You won’t, however, be able to double-click at any point to zoom in—you’ll have to use 
the zoom bar in the upper right for that.) Be sure to uncheck the box again to finish taking the 
measurement or to start a new one! 
 

(b) What is the distance between your two points? (2 points) 
 
 
 
 
Now that you have a distance, you need to find a value for time. Use the animation to figure out 
how long ago your two points separated from each other—because the animation jumps in fairly 
large intervals (20–40 million years), you will probably have to use the last time shown in the 
animation, which in reality may be a few million years too old, but that’s OK.  
 

(c) When was the last time they were connected in millions of years ago (Ma)? (2 points) 
 
 

(question continues on the next page)  

Ruler tool   
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(d) Now you are ready to make your calculation, using the formula above. Notice that if you 
simply take your numbers that you obtained above and plug them into the equation, you 
will get an answer whose units are in km/millions of years. Because that is rather difficult to 
comprehend, convert your answer to cm/year. (Remember that there are 100,000 cm in a 
km and that there are 1,000,000 years in a million years.) How fast has the Atlantic Ocean 
been spreading? Show your work for full credit. (1 point) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
(7) (a) Earthquakes occur wherever there is tectonic movement, both within plates and, most 
famously, at the boundaries between plates. Go to http://earthquake.usgs.gov/earthquakes, and 
find a recent earthquake that had a magnitude of at least 5.0. In what region was this earthquake, 
and what was its magnitude? (1 point each; 2 points total) 
 
 
 
 
 

(b) Find the location of this earthquake on a map (HINT: look at the web page you are on 
carefully—you may spot a quick way to do this!). Compare its location to a map of plates 
and plate boundaries (below). Did the quake occur as a result of activity at a boundary 
between two plates? If so, what kind of plate boundary is it? (2 points) 

 
 
 
 
 
(8) (a) As you will have learned in lecture, most of the world’s volcanic activity is also associated 
with plate tectonics boundaries. Go to http://www.volcano.si.edu/reports/usgs and find an example 
of recent volcanic activity (except Hawaii—don’t use Kilauea or any of the other Hawaiian 
volcanoes). Where is this volcano and what is the date of its most recent reported activity? (1 point 
each; 2 points total) 
 
 
 

(question continues on the next page)  

http://earthquake.usgs.gov/earthquakes
http://www.volcano.si.edu/reports/usgs
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(b) Find the location of this volcano on a map. Compare its location to the map of plates and 
plate boundaries. Was the volcano the result of activity at a plate boundary or above a hot 
spot? If it was a plate boundary, what kind of boundary is it? (1 point each; 2 points total) 

 
 
 
 
 
 
(9) (a) Look again at the map of the plates, and focus on where the different kinds of boundaries 
are (watch the symbols associated with each type). Now compare this map to a regular map of the 
world. What major water body is in the process of closing? HINT: it’s not an ocean, though it is 
connected to an ocean and contains ocean water! (1 point) 
 
 
 
 
 

(b) Why is this body of water closing—the motions of which to plates are causing the closure 
and what kind of tectonic movement is involved? (3 points) 

 
 
 
 
 
 

(c) What kind of geologic structure(s) (not landmasses!) will eventually be in place of this water 
body? (2 points) 
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Picture credit: Lutgens, F.K. and Tarbuck, E.J. 2005. Essentials of Geology, Ninth Edition. Boston: Prentice Hall. 
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(10) At right is a Google Earth picture showing the 
Hawaiian–Emperor chain, which comprises both islands 
(above sea level) and seamounts (below sea level, many 
or all of which used to be islands but have weathered so 
extensively that they no longer peek above the waves). 
All of these were created by the hot spot that is presently 
located under Hawaii—all of the other islands and 
seamounts in the chain are extinct volcanoes. Each was 
created when it was above the hot spot, but became 
detached from it as movement of the Pacific Plate 
carried it away from the position of the hot spot beneath 
the lithosphere. Some of these islands and seamounts 
are labeled, and the ages of the basalts making up those 
points are provided in millions of years (Ma = mega-
annum). 
 
 Launch Google Earth and find the Hawaiian–
Emperor chain. Note that the seamounts are not labeled (though some of the islands are), so use 
the picture above to locate the labeled points. Use the Ruler tool (see instructions with question 
#6b, above) to measure the distances in km between the labeled points. 
 

POINTS DISTANCE (km) AGE DIFFERENCE 
RATE OF 
MOTION (cm/yr) 

Detroit to Suiko    

Suiko to Nintoku    

Nintoku to Koko    

Koko to Diakakuji    

Diakakuji to Midway    

Midway to Necker    

Necker to Kaua’i    

Kaua’i to Hawaii    

MEAN PACIFIC PLATE RATE OF MOTION =  
 

(a) Record your distances in km in the table above. (1 point each; 8 points total) 
 

(b) Calculate the age difference between each of the two points and record those in the table. 
(1 point each; 8 points total) 
 

(question continues on the next page)  
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(c) Using the formula above (the same one you used for question #6), calculate the rate of 
motion in cm/yr of the Pacific Plate between the times the Hawaiian hot spot created each 
of the two points and record them in the table. Show your work below for at least two of 
your calculations below for full credit on all of your rates. (12 points) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(d) Average all of your individual rate times together to determine the mean rate at which the 
Pacific Plate has been moving for the last ≈80 million years and record this at the bottom of 
the table. (2 points) 
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NOTES FOR PLATE TECTONICS 
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LAB #12 
GEOLOGIC STRUCTURES   

Anticline in the Lower Cretaceous Xiagou Formation in northwestern Gansu Province, China. Photo by Jerry D. Harris. 



 179 

 The purpose of this exercise is to provide you with some experience understanding, 
recognizing, and interpreting various geologic structures (different kinds of folds and faults) and the 
application of this ability. 
 
Key Learning Points: 
 

• Understanding how different applications of stress to rocks result in different kinds of 
geologic structures. 

• Recognizing different kinds of geologic structures and how they form. 
• Reconstructing different kinds of geologic structures based on a limited data set. 
• Understanding how the ability to recognize geologic structures has economic importance.  

 
 
This exercise is worth 90 points; point values for each question are given at the end of each 
question. 
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(1) Use the Silly PuttyTM at your table to answer the following questions.  
 

(a) Roll the putty into a solid cigar shape. You will use the putty here to examine ductile 
behavior of a solid substance, meaning how it changes shape when a stress (force) is 
applied. Hold either end of the roll and S L O W L Y pull them apart. Describe below 
what happens to the shape of the putty roll as you do this, mentioning what happens as 
your start pulling, continue pulling, and what the end result is. (Ignore the effects of gravity 
in your description.) (3 points) 

 
 
 
 
 
 
 
 

(b) Roll the putty again as you did in question #1a above. You will use the putty here to 
examine brittle behavior of a solid substance, meaning how it breaks when a stress (force) is 
applied. Again, hold each end of the roll. This time, pull the ends apart very fast—as fast 
and hard as you can. Describe below what happens as you do this and what the end result 
is. (3 points) 

 
 
 
 
 
 
 
 
The different speeds at which you pulled on the putty in questions #1a and 1b above equate to 
applying the same stress (force)—in this case, tension—to the putty over different time spans (long 
and short). Despite the fact that us humans tend to think of rocks as immutably hard, solid things 
(which they usually are on day-to-day human scales), rocks behave very much like the putty when 
stressed (with a little variation depending on rock type, minerals present, and how the stress is 
applied). When rock behaves ductily, it can be strained, meaning it changes its shape in some way 
when stress is applied. Keep these differences in mind when doing the following exercises. From 
your “experiment” with the putty above, what associations do you see between the time spans over 
which the stress is applied and the kinds of strain that result? (2 points) 
 
  

Name:___________________________________________  Lab Section:________________________ 
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The diagrams in the next questions below are cross sections through the ground—think of them as 
rectangular chunks of the ground, several miles long, that have been removed from the Earth’s 
surface. In other words, what used to be the ground surface on top has been removed (and planed 
flat), and everything that used to connect on all sides have also been removed (and planed 
vertically flat). The flat top surfaces of each diagram is the surface on which you would be walking; 
you would not be able to see the front or side surfaces from that perspective.  
 
 
(2) (a) What kind of fold is depicted in the diagram at right? (1 point) 
 
 
 

(b) On the blank top and side of the 
cross section, draw in the strata 
as they would appear on those 
surfaces based on the structure 
you can see on the front surface. 
(7 points) 

 
 

(c) Draw a dashed line on the diagram indicating 
the position of the fold axis. (1 point) 

 
 

(d) If you were to stand on the dark brown layer in the center of the diagram, would the strata 
on either side of you get younger or older the farther away you would get? (1 point) 

 
 
 
(3) (a) What kind of fold is depicted in the 
diagram at right? (1 point) 
 
 
 

(b) On the blank top and side of the cross 
section, draw in the strata as they 
would appear on those surfaces based 
on the structure you can see on the 
front surface. (7 points) 

 
 

(c) Draw a dashed line on the diagram indicating the position of the fold axis. (1 point) 
 
 

(d) If you were to stand on the gray layer in the center of the diagram, would the strata on 
either side of you get younger or older the farther away you would get? (1 point) 
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(4) (a) What kind of fold is depicted in the diagram at 
left? (1 point) 

 
 

 
(b) On the blank top and side of 
the cross section, draw in the strata 
as they would appear on those 
surfaces based on the structure you 
can see on the front surface. (7 
points) 

 
 
 
 

(c) If you were to stand on the beige layer in the center of the diagram, would the strata on 
either side of you get younger or older the farther away you would get? (1 point) 

 
 
 
 
 
(5) (a) To assess the possibility that the strata and geologic 
structures in a given area might contain oil and natural gas, 
you have just taken a vertical drill core through the strata 
in the area depicted on the cross section at right—your 
core is shown in its original position on the front 
surface of the diagram. On the blank front and 
sides of the cross section, draw in the strata 
as they would appear on those surfaces 
based on the top surface and your drill 
core. (7 points) 
 
 

(b) What kind of fold is this? (2 
points) 

 
 
 
 

(c) Draw an arrow (not just a line!) along the plunge of this fold that indicates the direction and 
approximate dip (angle) of the plunge of this fold. (2 points) 
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(6) (a) Now you have been reassigned to examine the oil and 
natural gas resources in a different area with different 
geological structures. As before, you take a drill core 
through the strata in the area depicted on the cross 
section at right, and your core is again shown in its 
original position on the front surface of the 
diagram. On the blank front and sides of the 
cross section, draw in the strata as they 
would appear on those surfaces based on 
the top surface and your drill core. (7 
points) 
 
 

(b) What kind of fold is this? (1 point) 
 
 
 
 
 
 
(7) (a) On the diagram at right, strata are shown on 
one face. A normal fault (the diagonal line 
on the front face) cuts through this 
block. Draw on both the front 
face and the top surface what the 
strata would look like with this 
normal fault in place. (5 points) 
 
 
 
 
 
 
 
 

 
(b) The diagram at left is similar 

to the one in question #6a, 
but now has a reverse fault 
running through it. Draw on 
both the front face and the 
top surface what the strata 
would look like with this 
reverse fault in place. (5 
points) 

(question continues on the next page)  
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(c) The diagram at 
left is similar to the 
previous one, but instead 
of a typical reverse fault, 
it has a variation called a 
thrust fault running 
through it. Thrust faults 

happen at very low angles 
(closer to horizontal), whereas 

reverse (and normal) faults are at high 
angles (closer to vertical). Draw on both the front 

face and the top surface what the strata would look like with this strike-slip fault in place 
(note carefully what the strata shown are telling you!). (5 points) 

 
 
 
 

(d) The diagram at right is similar to the previous 
ones, but has both a dike (igneous 
intrusion) and a strike-slip 
(transform) fault 
running through it. 
Draw on both the 
front face and the 
top surface what 
the strata and dike 
would look like 
with this strike-slip 
fault in place. (5 points) 
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 Understanding geological structures—especially ones that are not entirely visible at the 
surface of the Earth—are extremely important in locating oil and natural gas reserves. Without 
understanding where structures are underground, drilling for oil and natural gas would be a 
completely random process of guesswork…and drilling is extremely expensive! Fortunately, various 
kinds of geologic structures can be beneficial because they can serve as traps for the oil and natural 
gas. Oil (a liquid) and natural gas are both produced from the alteration of the remains of marine 
plankton, primarily algae. Both are much less dense than groundwater, so under the pressure 
(weight) of overlying rock, they are squeezed from their source rocks and rise through strata that 
are permeable (meaning that they allow the passage of gases and fluids). To be permeable, any 
stratum through which the oil and natural gas rise must be (1) highly porous, meaning that it has 
lots of interconnected spaces between individual sediment grains (typical of coarser-grained 
sedimentary rocks, such as sandstones and conglomerates), and/or (2) heavily fractured, creating a 
series of narrow but interconnected passages. The oil and natural gas rise until they hit a cap rock 
layer that is impermeable. A stratum will be impermeable if it has pore spaces that are very small 
and not well connected to one another (typical of finer-grained sedimentary rocks, such as 
mudstone and shale) and/or is not heavily fractured. Some kinds of geologic structures can trap 
rising oil and natural gas in much shallower places underground than the source rock itself. 
Identifying the positions of such traps is highly desirable because drilling to shallow depths is much 
less expensive than drilling very deeply into the source rock, and the less a company spends to 
drill, the more cheaply they can sell the oil and natural gas (making it attractive to buy by 
consumers) and still make a profit! 
 
 The diagrams below shows the details of underground geologic structures that can serve as 
oil and natural gas traps; the legend provided below shows the rock types involved in both. Use this 
to answer the following questions. 
 

 
 
 
(8) (a) The diagram below shows the details of 
an underground fold. The black shale, which 
is several thousands of meters underground, is 
a producer of oil and natural gas. Assume that 
the overlying limestone is fractured. On the 
diagram, indicate where the trap is by drawing 
in the pool that will form as the oil and natural 
gas collect under the cap rock. (4 points) 
 

(b) Which layer is acting as the cap rock 
for this trap and why is it a cap rock? 
(2 points) 
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(9) (a) The diagram below shows the details of an underground fault. The black shale, which is 
several thousands of meters underground on both sides of the fault, is, as in question #8, a 
producer of oil and natural gas. On the diagram, indicate where the traps are by drawing in the 
pools that will form as the oil and natural gas collect under the cap rock. (3 points) 

 
(b) What kind of fault is this? (1 point) 

 
 
 
 
 

(c) The fault in the diagram above has created one advantageous spot for recovering oil and 
natural gas cheaply and easily. Indicate on the diagram where this area is and describe here 
why this spot is advantageous (accounting, in your answer, for the fault and other geologic 
structures in the area depicted in the diagram). (3 points) 
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(d) Other than the advantageous spot you noted in part (c) above, oil and natural gas could be 
obtained from elsewhere in the area depicted—after all, the source rock is producing oil 
and natural gas along the entirety of its preserved length!—although it would be more 
expensive to get it because it’s deep underground. To get the oil and natural gas most 
easily, you could frack (artificially fracture) part of any impermeable cap rock layers to 
create a series of fractures that would allow the oil and natural gas to permeate a cap rock 

layer, or even the source rock layer 
itself. Fracking works by drilling 
down to the layer that needs to be 
fractured, drilling a long way into it 
horizontally, then pumping fluids 
and gases into the horizontal tunnel 
at high pressures to create the 
fractures (see diagram at left, which 
depicts fracking a shale horizon in 
New England called the Marcellus 
Shale, which is a huge reservoir of 
otherwise locked-up natural gas). If 
you had a limited amount of funds 
and could only frack any cap rock 
layers in one small area in the 
diagram above, where would that 
area be? Mark that spot on the 
diagram above with a star and 
explain why this location would be 
the best. (3 points) 
 

 
 
 
  

Picture credit: http://geology.com/articles/hydraulic-fracturing/marcellus-gas-
well.jpg 
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NOTES FOR GEOLOGIC STRUCTURES 
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